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1.  Getting Started in LIMS 

In this chapter, you will receive instruction about the following: 

 Accessing Support Resources 2 

 Using this Guide 2 

 Understanding the General Workflow 4 

 Starting SiteManager LIMS 6 

 Understanding the Main Functions of LIMS 8 

 Understanding the LIMS Toolbar 9 

 Opening Multiple LIMS Windows 10 

 Controlling the Display of Multiple Windows 11 

 Closing Versus Exiting 12 

 Changing Security Groups 14 

 Review 15 
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Accessing Support Resources 
The following SiteManager and LIMS documentation and support 
resources are available to KYTC staff. 

KYTC Help Desk 

Contact the KYTC Help Desk at the following number: 

 (502)564-4780 

KYTC Division of Materials Web Site 

Access the KYTC Division of Materials web site at the following URL: 

 http://transportation.ky.gov/materials 

View and download the following from the web site: 

 Training manuals 

 LIMS policy and procedures 

Using this Guide 
This guide consists of chapters. Each chapter consists of the following 
sections: 

 Objectives 

 Topics 

 Instructor-Led Exercises 

 Review 

 Summary 
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Objectives 

Each chapter begins with the objectives both you and the instructor should 
try to achieve. 

Topics 

Each chapter contains topics corresponding to these objectives. Each topic 
contains a short description and figure of the Trns•port SiteManager® and 
LIMS function being addressed. To further elaborate on the functions, we 
include a table of field definitions after each figure. 

Usage: The field definitions include KYTC policy and procedures. 

Instructor-Led Exercises 

Identify instructor-led exercises by the bulldozer icon and sequential 
numbering. Each instructor-led exercise is very explicit and details the 
specific steps to follow and the data to use. 

 Exercise 5-2 
Figure 1-1.  The Bulldozer Icon and Sequential Numbering  
Used to Identify Instructor-Led Exercises 

Review 

Each chapter ends with a review. The review summarizes the main points 
learned and all of the SiteManager and LIMS functionality covered in the 
chapter. Each review is as an excellent reference for the summary exercise 
that follows. Remember to use the reviews when you return to your office 
and begin using SiteManager and LIMS on your own. 

Summary 

Summary exercises provide a means to practice the skills you acquired in 
the chapters. Read them carefully; the summary exercises are more 
general than instructor-led exercises, but they still provide steps to follow 
and data to use. As you perform the summary exercise, refer to the review 
steps for tips on navigation. 
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Understanding the General Workflow 
The following diagram shows the general workflow between SiteManager 
software’s Materials Management and LIMS components. 

Approved
Lists

Material
Information

LIMS

Management Functions

Sampling and Testing

Mix DesignSystem
Administration

Materials Management

 
Figure 1-2.  General Workflow 
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Trns•port SiteManager 

SiteManager is a comprehensive construction management software 
product that covers the complete construction and materials management 
process from contract award through contract finalization in one 
enterprise-wide software package. 

SiteManager LIMS Component 

The Lab Information Management System, referred to as LIMS, integrates 
seamlessly with SiteManager. LIMS streamlines the sampling and testing 
workflow from recording a sample to reviewing and authorizing samples. 

When a sample arrives, enter the information into SiteManager’s Maintain 
Sample Information window to capture the sample details and assign 
default tests. 

After you assign tests, the sample arrives in the Receive Sample in Lab 
Unit queue. Once you receive the sample in LIMS, the Enter Tests Results 
queue displays the tests based upon qualifications and assigned lab units. 

Completed tests from the Enter Test Results queue appear in the Review 
Tests queue. Review results, mark tests as complete, requeue tests, or 
order retests. After you complete the review of all assigned tests on a 
sample, review and authorize the sample in the Review Samples queue. If 
needed, send test results back to the lab. 

At any time in the process, monitor the test assignments and easily add or 
cancel tests in the Maintain Test Queue window. Access all available 
information about all samples with View-Only Sample Information 
window. 
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Starting SiteManager LIMS 
You can access LIMS directly from SiteManager. With the Maintain 
Sample Information window open, click the LIMS button on the 
SiteManager toolbar. You do not have to log into LIMS when entering the 
application this way. 

Alternatively, to access LIMS without starting SiteManager, double-click 
the LIMS desktop icon. When accessing LIMS from the desktop, the 
AASHTO SiteManager LIMS Login window appears. SiteManager and 
LIMS use the same user ID and password. 

Note:  If prompted to change your password, do so in SiteManager. 

 
Figure 1-3.  AASHTO SiteManager LIMS Login Window 

NOTE 

YOU WILL NOT SEE THE 
LOGIN WINDOW WHEN 
LAUNCHING LIMS FROM 
SITEMANAGER. 
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 Exercise 1-1 

In this exercise, learn how to launch LIMS from SiteManager.  

User ID:  alincoln Password:  kentucky Connection:  Server 
Group Name:  CENTRAL MATERIALS LAB MANAGERS (CMLM) 
Keys:  NA 

1. Start and log on to SiteManager as user alincoln. SiteManager 
displays the SiteManager Panel window. 

2. Double-click the Materials Management icon. SiteManager 
displays the Materials Management panel. 

3. Double-click the Sampling and Testing icon. SiteManager 
displays the Sampling and Testing panel. 

4. Double-click the Sample Information icon. SiteManager 
displays the Maintain Sample Information window. 

5. On the toolbar, click the Open LIMS button. SiteManager 
displays the AASHTO SiteManager LIMS application window. 

You’ve launched LIMS from SiteManager. 

NOTE 

EXPLAIN HOW KEYS 
PRIOR TO EXERCISES 
REFLECT THE 
ASSUMPTIONS ABOUT 
THE WAY DATA 
SHOULD BE STAGED 
TO CORRECTLY 
PERFORM THE 
EXERCISE. HELPFUL 
WHEN PERFORMING 
EXERCISES OUT-OF-
ORDER. 
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Understanding the Main Functions of LIMS 
The Navigation Panel contains icons that correspond to the main 
functional areas of LIMS. A user’s security group determines the available 
icons on the Navigation Panel. 

For example, a lab technician would have the Receive Sample in Lab Unit, 
and Enter Test Results icons appear on the Navigation Panel. A lab 
manager would have access to different icons that reflect their group roles 
and responsibilities. 

 
Figure 1-4.  SiteManager LIMS - Navigation Panel - All Available Icons Displayed 

The following table includes information about each of the main 
functional areas of LIMS. 

 

LIMS Window Function 
View-Only Sample 
Information 

Use to access inquiry-only information about samples 
in addition to a history of the samples received, tests 
assigned and test statuses. 

Receive Sample in 
Lab Unit 

Use to receive samples in the lab unit where the 
testing will be performed. 

Enter Test Results Use to record test data. 
Review Tests Use to approve tests or request a re-queue or retest. 
Review Samples Use to finalize samples or to send samples back to the 

lab unit for a review of tests. 
Maintain Test Queue Use to add tests, cancel tests, or change other 

information about the test queue. 

Table 1-1.  LIMS Windows and Their Functions 

NOTE 

EXPLAIN EACH ICON AT A 
HIGH LEVEL. 

USAGE 

OFFICE PERSONNEL WILL 
HAVE PERMISSION TO 
ENTER TEST DATA EVEN 
WITHOUT CERTIFICATION 
TO ACTUALLY PERFORM 
TEST. 
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Understanding the LIMS Toolbar 
Many of the functions available from the menus are also conveniently 
available from the LIMS toolbar. 

 
Figure 1-5.  SiteManager LIMS - Toolbar - Common Buttons Displayed 

 Exercise 1-2 

In this exercise, learn how to identify the buttons on the toolbar. 

User ID:  alincoln Password:  kentucky Connection:  Server 
Group Name:  CENTRAL MATERIALS LAB MANAGERS (CMLM) 
Keys:  NA 

1. On the Navigation Panel window, double-click the Enter Test 
Results icon. SiteManager LIMS displays the Enter Test 
Results window. 

2. Place your cursor over a button on the toolbar. LIMS displays 
the name of the button. 

3. Move your cursor to another button. 

4. Repeat Steps 1 and 2 until you have reviewed all of the buttons 
on the toolbar. Note that most of these buttons are identical to 
those on the SiteManager Toolbar. 

You’ve identified the buttons on the SiteManager LIMS toolbar. 

TIP! 

WHILE LEARNING THE 
BUTTONS, RIGHT-CLICK 
ON TOOLBAR THEN 
SELECT ‘SHOW TEXT’ 
CHOICE. 
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Opening Multiple LIMS Windows 
In many instances, you will be working in a SiteManager LIMS window 
and may need to open another window without closing the current one. 
Having opened more than one window of LIMS, you can then control how 
the windows display. 

 Exercise 1-3 

In this exercise, you will learn how to open a second window 
without closing the first window. 

User ID:  alincoln Password:  kentucky Connection:  Server 
Group Name:  CENTRAL MATERIALS LAB MANAGERS (CMLM) 
Keys:  NA 

1. On the toolbar, click the SiteManager LIMS Panel button. 
SiteManager LIMS displays the Navigation Panel window. 

2. Double-click the Maintain Test Queue icon. SiteManager 
LIMS displays the Maintain Test Queue window. 

You’ve opened a second window. 

NOTE 

IF LIMS TOOLBAR 
DISAPPEARS, CLOSE AND 
REOPEN WINDOW.  
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Controlling the Display of Multiple Windows 
Having opened more than one LIMS window, you may now use a variety 
of standard Microsoft® Windows® operating system methods to control 
the display of the SiteManager windows and your movement between 
them. 

 
Figure 1-6.  Window Menu - Multiple LIMS Windows Active 

Using Tile 

To divide the screen into the number of open LIMS windows to compare 
the entries in each, use the Tile Vertically or Tile Horizontally features. 

Note: Info Tech does not recommend tiling when more than two LIMS 
windows are active since you will not be able to see enough of each 
window to make it worthwhile. With three windows active, tiling will give 
each window only one third of the screen. 

Using Layer 

To display the active LIMS window in a full screen display, use the Layer 
feature. Typically, you will use Layer to give each active window a full 
display or to return a single active window to full display after closing 
other windows. 
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Closing Versus Exiting 
LIMS follows the same principles of closing a window versus exiting the 
application as other applications on a Microsoft® Windows® operating 
system. When you are in a LIMS window and you wish to end your work 
in it, but still continue to work in LIMS, you should close the window. As 
with other applications, you only exit when you complete your work and 
want to log off of the application. 

Closing 

Close a window in the following three ways: 

 Click the Close button on the toolbar. 

 Select the Close choice on the File menu. 

 Click the Close button on the right side of the window’s 
title bar. 

Exiting 

Exit an application in the following three ways: 

 Click the Exit button on the toolbar. 

 Select the Exit choice on the File menu. 

 Click the Exit button on the right side of the application’s 
title bar. 
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 Exercise 1-4 

In this exercise, you will first tile a couple of windows, close a 
window, and then open a sample record. 

User ID:  alincoln Password:  kentucky Connection:  Server 
Group Name:  CENTRAL MATERIALS LAB MANAGERS (CMLM) 
Keys:  NA 

1. On the Window menu, select the Enter Test Results choice. 
LIMS displays the Enter Test Results window. 

2. To close the active window, click the Close button. 

3. To exit the application, click the Exit SiteManager LIMS 
button. LIMS displays a message prompting you to verify your 
decision. 

4. In the message, click the Yes button. 

5. In SiteManager, on the toolbar, click the Exit SiteManager 
button. 

You’ve controlled window display, closed and exited. 

NOTE 

IF YOU CLICK THE ‘X’ ON 
THE TITLE BAR TO EXIT 
THE APPLICATION, LIMS 
WILL NOT PROMPT YOU 
TO CONFIRM YOUR 
DECISION. 



1-14 Getting Started in LIMS 

Changing Security Groups 
Your system administrator grants access to SiteManager LIMS windows 
and panels by assigning security groups to users. Your SiteManager user 
ID, when assigned to a security group, determines the windows to which 
you have access. Most users will belong to only one security group, but on 
occasion, a user may need to have access to more than one group. 

If your user ID is assigned to only one group, LIMS displays the 
Navigation Panel with the functions available to that security group. If you 
log on with a user ID assigned to multiple security groups, SiteManager 
LIMS will prompt you to select a security group from the Select Group 
window before displaying the Navigation Panel. 

 
Figure 1-7.  Select Group Window 
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Review 
To start SiteManager: 

1. On your desktop, double-click the SiteManager desktop icon. 

To log on to SiteManager: 

1. Start SiteManager. 

2. On the SiteManager Logon window, in the User ID field, type 
your user ID. 

3. Press the Tab key. 

4. In the Password field, type your password. 

5. Click OK. 

To open more than one window: 

1. Open the first window of SiteManager. 

2. Open the SiteManager Panel. 

3. Open the other window of SiteManager. 

To tile windows: 

1. Open the number of windows that you want to tile. 

2. Click the Window menu. 

3. Click the Tile Horizontally choice. 

4. Click the Tile Vertically choice. 

To cascade windows: 

1. Open the number of windows that you want to cascade. 

2. Click the Window menu. 

3. Click the Cascade choice. 

To navigate between cascaded windows: 

1. Click the visible portion of the window you want to view. 
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To layer windows: 

1. Open the number of windows that you want to layer. 

2. Click the Window menu. 

3. Click the Layer choice. 

To navigate between layered windows: 

1. Click the Window menu. 

2. From the list, click the name of the window you want to view. 

To close a window: 

1. On the toolbar, click the Close button. 

or 

1. Click the File menu. 

2. Click the Close choice. 

or 

1. On the window’s title bar, click the Close button. 

To start (and log on to) LIMS: 

1. On the desktop, double-click the LIMS desktop icon. 

2. In the SiteManager LIMS Login window, in the User ID field, 
type your user ID. 

3. In the Password field, type your password. 

4. In the Connect to dropdown list, select the Server or 
Standalone choice. 

or 

1. In SiteManager, open the Maintain Sample Information 
window. 

2. On the toolbar, click the LIMS button. 
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To change security groups: 

1. Using a user ID that belongs to multiple security groups, log on 
to LIMS. 

2. In the Select Group window, select a security group. 

3. Click the OK button. 

To exit LIMS: 

1. On the toolbar, click the Exit button. 

or 

1. Click the File menu. 

2. Click the Exit choice. 

or 

1. On the application’s title bar, click the Exit button. 
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2.  Assigning Destination Labs and Tests 

In this chapter, you will receive instruction about the following: 

 Understanding the General Workflow 2 

 Modifying Sample Records 3 

 Understanding Locked Samples 17 

 Review 18 

 Summary 20 
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Understanding the General Workflow 
The following diagram shows the general workflow between SiteManager 
software’s Materials Management and LIMS components. The highlighted 
area denotes the functionality addressed in this chapter. 

Approved
Lists

Material
Information

LIMS

Management Functions

Sampling and Testing

Mix DesignSystem
Administration

Materials Management

 
Figure 2-1.  General Workflow – Assigning Destination Labs and Tests – Detail 
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Modifying Sample Records 
To send a sample record into LIMS, assign a destination lab and tests. 

Recording Other Sample Data 

To assign the sample to a destination lab, use the Maintain Sample 
Information window’s Other panel. If you have a sample intended 
for multiple destination labs, add a row for each location. 

Note:  If you have not assigned a destination lab, SiteManager 
displays a message to inform you when you attempt to assign tests. 

 
Figure 2-2.  Maintain Sample Information Window – Other Panel 

 

Field Name Description 
Sample Identifies sample. 
Type For Non-Construction types of contracts, select the type of 

non-construction contract. For LIMS samples, select the 
Destination Lab choice. 

ID Select the appropriate destination where the sample will 
be tested. 

Description Full description of the selected destination lab. 

Table 2-1.  Maintain Sample Information Window – Other Panel – Fields 

USAGE 

YOU WILL NO 
LONGER HAVE TO 
ASSIGN A LAB ID TO 
EACH TEST. INSTEAD 
ON THE OTHER 
PANEL, YOU WILL 
ASSIGN A 
DESTINATION LAB AT 
THE SAMPLE LEVEL. 

YOU WILL NO 
LONGER ASSIGN 
TESTS ON THE 
TESTS PANEL. 
INSTEAD, USE THE 
‘OPEN ASSIGN 
TESTS’ BUTTON ON 
THE TOOLBAR. 
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Understanding Lab Hierarchy in LIMS 

The following figure demonstrates the structure of the labs and the 
importance of selecting the correct destination lab as it relates to its flow 
through LIMS. 

Destination lab is the
central receiving point (building)
where the lab units are located.

Lab units are where
the tests are performed.

Testers may belong
to multiple lab units.

Sample

Sampler

Sampler takes a sample,
creates a sample record,

and specifies a destination lab.

Mobile/Field Lab

D-01 Paducah Section
Central Office Materials

D-01 Paducah Section D-01 Materials SectionPhysical SectionChemistry SectionAggregate Section

D-01 Materials Section

...

 
Figure 2-3.  KYTC Lab Hierarchy in LIMS 
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 Exercise 2-1 

In this exercise, learn how to assign a destination lab for a sample. 

User ID:  dsawyer Password:  kentucky Connection:  Server 
Group Name:  CENTRAL MATERIALS LAB TECHNICIANS (CMLT) 
Keys:  NA 

1. Start and log on to SiteManager as user dsawyer. 
SiteManager displays the SiteManager Panel window. 

2. Double-click the Materials Management icon. 
SiteManager displays the Materials Management panel. 

3. Double-click the Sampling and Testing icon. SiteManager 
displays the Sampling and Testing panel. 

4. Double-click the Sample Information icon. SiteManager 
displays the Maintain Sample Information window. 

5. On the toolbar, click the Open button. SiteManager displays 
the Select Sample window. 

6. In the Sample area, click the Sample ID column heading. 
SiteManager makes the Find field available. 

7. In the Find field, type 4567. SiteManager selects the 
01310DAS0904567 sample record. 

8. Click the OK button. SiteManager displays the Maintain 
Sample Information window. 

9. Click the Other tab. SiteManager displays the Other panel. 
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Now, let’s add the first destination lab. 

10. In the Type dropdown list, select the Destination Lab 
choice. 

11. Using the right mouse button, click on the ID field. 

12. On the object menu, select the Search choice. SiteManager 
displays the Search Window. 

13. Click the Destination Lab column heading. SiteManager 
sorts the column. 

14. In the Destination Lab column, double-click  
D-01 Paducah Section. SiteManager displays DL01300 in 
the ID field. 

15. On the toolbar, click the Save button. 

Now, let’s add the second destination lab. 

16. On the toolbar, click the New button. SiteManager inserts a 
blank row. 

17. In the Type dropdown list, select the Destination Lab 
choice. 

18. Using the right mouse button, click on the ID field. 

19. On the object menu, select the Search choice. SiteManager 
displays the Search Window. 

20. Click the Destination Lab column heading. SiteManager 
sorts the column. 

21. In the Destination Lab column, double-click  
D-01 Materials Section. SiteManager displays DL01210 in 
the ID field. 

22. On the toolbar, click the Save button. 

You’ve opened an existing sample record and assigned multiple 
destination labs. 

TIP! 

YOU MAY NEED TO 
CLICK TO GIVE 
FOCUS BEFORE 
CLICKING THE NEW 
BUTTON. 

TIP! 

AFTER INSERTING A 
NEW ROW, TYPE THE 
FIRST LETTER OF 
YOUR DESIRED 
CHOICE TO MAKE A 
SELECTION. 

USAGE 

DESTINATION LAB 
(DL######)  
IS A SMART NUMBER. 

DL - DESTINATION LAB 
## - DISTRICT NUMBER 
### - SECTION OR CREW 
NUMBER 
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Assigning Tests 

To assign tests, complete all required fields for the sample record. 
Then, on the Other panel, assign a destination lab. Finally, on the 
toolbar, click the Open Assign Tests button. 

To accept default tests or assign additional tests, use the Assign Sample 
Tests window. If you are not ready to assign tests, click the Cancel button. 

The system administrator has pre-determined the default tests for 
materials, because you commonly perform these tests on these materials. 
If you desire another test for a material, you must click the More button to 
add additional tests. Once you save tests, you cannot reassign them from 
the Maintain Sample Information window; SiteManager makes the Open 
Assign Tests button unavailable. 

Note: Do not assign tests on the Tests panel; instead click the Open 
Assign Tests button on the toolbar. 

 
Figure 2-4.  Assign Sample Tests Window 

 

Field Name Description 
Sample ID Automatically populated by the system with the value that 

appears on the Basic Sample Data panel. 
Sample Type Identifies the purpose of the sample. 

Material Code KYTC-specific code that identifies the material. 

Accept Default 
Tests 

Click this button to accept default tests automatically 
associated by selecting the material. 

Cancel Click this button to close the Assign Sample Tests 
window. 

More Click this button to expand the Assign Sample Tests 
window to view panes with available tests and the tests to 
be assigned. 

Table 2-2.  Assign Sample Tests Window – Field 

USAGE 

UNTIL YOU BECOME 
COMFORTABLE WITH 
THE DEFAULT TEST 
ASSIGNMENT, CLICK 
THE ‘MORE’ BUTTON 
TO SEE DEFAULT 
TESTS. ONCE 
COMFORTABLE, 
CLICK THE ‘ACCEPT 
DEFAULT TESTS’ 
BUTTON.  
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Adding Additional Tests 

If you click the More button, SiteManager expands the Assign Sample 
Tests window to reveal additional tests and the tests to be assigned. 

The Additional Available Tests pane shows tests that you can assign for 
that material, but these have not been assigned as default tests. 

Important!  Pay particular attention to the Lab Unit column when 
selecting additional available tests. Be sure to select the appropriate test 
for the desired lab unit. 

You only have one opportunity to assign tests. If you are unsure about 
changes to make, click the Cancel button. Once you click the Save Tests 
button, then the Open Assign Tests button is no longer available. If you 
mistakenly assign tests, a Lab Manager will be able to modify the assigned 
tests. 
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Removing Tests 

You can remove any test except tests marked as required. If you attempt to 
remove a required test, SiteManager displays a message to inform you that 
you cannot remove required tests. 

 
Figure 2-5.  Assign Sample Tests Window (After Clicking the More Button) 
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Field Name Description 
Sample ID Identifies the sample. Automatically populated by the 

system with the value that appears on the Basic Sample 
Data panel. 

Sample Type Identifies the type of sample. 
Material Code KYTC-specific code that identifies the material. 
Additional 
Available Tests 

List of tests associated to a material, but not assigned as 
default tests.  

Test Description Description of the test. 
Lab Unit Lab assigned to perform the test. 
Test Method KYTC-defined code to identify the test. 
Tests to be 
Assigned 

List of defaults tests associated to a material. 

Default Test Indicates test is assigned to be completed, unless 
removed. 

Test Rqrd Test Required. Indicates test is required and cannot be 
removed. 

Autofinalize Indicates test does not have to be authorized in sample 
review assuming all tests are In Spec. 

Add Click to add a test to the Tests to be Assigned pane. 
Remove Click to remove a test from the Tests to be Assigned pane. 
Save Tests Click to lock the sample with the currently assigned test 

choices. 
Cancel Click to exit the Assign Sample Tests window. 

Table 2-3.  Assign Sample Tests Window (After Clicking the More Button) – Fields 
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 Exercise 2-2 

In this exercise, learn how to remove unnecessary tests and assign 
an additional test. 

User ID:  dsawyer Password:  kentucky Connection:  Server 
Group Name:  CENTRAL MATERIALS LAB TECHNICIANS (CMLT) 
Keys:  01310DAS0904567 (sample ID) 

1. On the toolbar, click the Open Assign Tests button. 
SiteManager displays the Assign Sample Tests window. 

2. Click the More button. SiteManager expands the Assign 
Sample Tests window. 

Note:  The message on the window informs you that assigning tests to the 
sample will lock the sample. If you are not ready to assign tests, click the 
Cancel button to return to the Basic Sample Data panel. 

Now, let’s remove the unnecessary default tests for each lab unit. 

3. In the Tests to be Assigned pane, click and drag the 
scrollbar to the right to display the Lab Unit column. 

4. In the Test Description column, select the 
VISUAL INSPECTION FOR CONCRETE SECTION test for 
lab unit LU01210. 

5. On your keyboard, press and hold the Ctrl key. 

6. In the Test Description column, select the  
VISUAL INSPECTION FOR CONCRETE SECTION test  
for lab unit LU01300. 

7. On your keyboard, release the Ctrl key. 

8. On the Assign Sample Tests window, click the Remove 
button. SiteManager moves the test to the Additional 
Available Tests pane. 

TIP! 

CTRL+CLICK TO 
SELECT MORE THAN 
ONE TEST AT A TIME. 

USAGE 

LAB UNIT 
(LU######) IS A 
SMART NUMBER. 

LU - LAB UNIT 
## - DISTRICT 
NUMBER 
### - SECTION OR 
CREW NUMBER 

USAGE 

VISUAL INSPECTION 
FOR CONCRETE 
SECTION TEST WILL 
NOT APPEAR AS A 
DEFAULT IN 
PRODUCTION. 

THEY APPEAR IN 
TRAINING TO 
DEMONSTRATE HOW 
TO REMOVE TESTS. 
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Now, let’s add an additional test. 

9. In the Additional Available Tests pane, in the  
Test Description column, select the 
CONCRETE CORES test for lab unit LU01210. 

10. Click the Add button. SiteManager moves the test to the 
Tests to be Assigned pane. 

Now, let’s save the tests. 

Caution! Be sure you are finished. When you click the Save Tests 
button SiteManager closes the Assign Sample Tests window, 
displays the Basic Sample Data panel, locks the sample to prevent 
modifications, and changes the status from Pending to Logged. 

11. Click the Save Tests button. SiteManager closes the Assign 
Sample Tests window. 

You’ve removed unnecessary tests and added an additional test. 

NOTE 

THE SYSTEM 
CHANGED THE 
SAMPLE STATUS 
FROM PENDING TO 
LOGGED 
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Accepting Default Tests 

In LIMS, tests have been associated to materials. Based on the material 
you select, default tests are available to assign automatically. 

 Exercise 2-3 

In this exercise, assign a single destination lab and learn how to 
accept the default tests assigned to a sample. 

User ID:  dsawyer Password:  kentucky Connection:  Server 
Group Name:  CENTRAL MATERIALS LAB TECHNICIANS (CMLT) 
Keys:  01310DAS0904567 (sample ID) 

1. On the toolbar, click the Open button. SiteManager displays 
the Select Sample window. 

2. In the Sample area, click the Sample ID column heading. 
SiteManager makes the Find field available. 

3. In the Find field, type 0321. SiteManager selects the 
01310DAS090321 sample record. 

4. Click the OK button. SiteManager displays the Maintain 
Sample Information window. 

5. Click the Other tab. SiteManager displays the Other panel. 

Now, let’s add a single destination lab. 

6. In the Type dropdown list, select the Destination Lab 
choice. 

7. Using the right mouse button, click on the ID field. 

8. On the object menu, select the Search choice. SiteManager 
displays the Search Window. 

9. Click the Destination Lab column heading. SiteManager 
sorts the column. 

10. In the Destination Lab column, double-click Central 
Office Materials. SiteManager displays DL00640 in the ID 
column. 

USAGE 

IN MOST CASES, 
ACCEPT THE 
DEFAULT TESTS. 
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11. On the toolbar, click the Save button. 

12. On the toolbar, click the Open Assign Tests button. 
SiteManager displays the Assign Sample Tests window.  

13. Click the More button. SiteManager expands the Assign 
Sample Tests window. View the tests to be assigned by 
default. 

14. Click the Save Tests button. SiteManager closes the Assign 
Sample Tests window and makes the Open Assign Tests 
button unavailable and changes the status from Pending to 
Logged. 

Now, let’s view the tests assigned by default. 

15. Click the Tests tab. SiteManager displays the Tests panel. 

16. What is the name of the test you assigned? _____________ 

You’ve assigned a single destination lab and accepted default tests. 

ANSWERS 

16.  ASPHALT 
EMULSION 
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Printing Sample Labels 

After you create a sample record in SiteManager, print a sample label. The 
sample label identifies the sample by the sample ID and other fields to pair 
the sample with the correct record in SiteManager. 

 
Figure 2-6.  Print Label Window 

 

Field Name Description 
Available Printers Printers connections established on the computer. 
Print Click to print to the selected printer. 
Number of Copies Number of labels to print to the selected printer. 
Cancel Click to exit the window. 

Table 2-4.  Print Label Window – Fields 

USAGE 

YOU WILL NO 
LONGER HAVE TO 
PRINT LABELS FROM 
BUSINESS OBJECTS. 
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 Exercise 2-4 

In this exercise, learn how to print a label. 

User ID:  dsawyer Password:  kentucky Connection:  Server 
Group Name:  CENTRAL MATERIALS LAB TECHNICIANS (CMLT) 
Keys:  01310DAS090321 (sample ID) 

1. On the toolbar, click the Print Label button. SiteManager 
displays the Print Label window. 

2. In the Available Printers dropdown list, select the desired 
choice. 

3. In the Number of Copies field, type 2.  
 
Note: Do NOT click the Print button. This exercise is for 
demonstration purposes only. 

4. Click the Cancel button. SiteManager displays the Maintain 
Sample Information window’s Tests panel. 

You’ve accessed the window where you can print sample labels. 

NOTE 

WARN CLASS! DO 
NOT CLICK PRINT IN 
THE FOLLOWING 
EXERCISE. 
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Understanding Locked Samples 
Important! If you must modify a locked sample record, but only have 
lower-level group access rights (for example, lab technician), contact a 
member of an upper-level group (for example, lab manager) to make 
changes.  

SiteManager populates the Locked By and Lock Date fields when you 
save a sample record, but that only denotes the last person to modify the 
sample and the date the person made the change. SiteManager officially 
locks a sample after you assign tests. The Assign Sample Tests window 
includes a note to inform you that assigning tests will lock the sample. 
Users with the same or higher office-level access as that recorded at the 
bottom of the Basic Sample Data panel have rights to edit the sample 
record; all others have inquiry-only access. 

 
Figure 2-7.  Maintain Sample Information Window - Basic Sample Data Panel - 
Lock Detail 
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Review 
To access the Sampling and Testing panel: 

1. On the Main Panel, double-click the Materials 
Management icon. 

2. On the Materials Management panel, double-click the 
Sampling and Testing icon. 

To modify a sample record: 

1. On the Sampling and Testing panel, double-click the 
Sample Information icon. 

2. On the toolbar, click the Open button. SiteManager displays 
the Select Sample window. 

3. In the Sample ID column, scroll to and double-click the 
desired sample ID. SiteManager displays the Maintain 
Sample Information window. 

4. Change the values in the desired fields on all panels. 

5. On the toolbar, click the Save button. 

To accept the default tests assigned to a sample: 

1. On the Basic Sample Data panel, click the Open Assign 
Tests button. 

2. In the Assign Sample Tests window, click the Accept 
Default Tests button. 
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To add tests: 

1. On the Basic Sample Data panel, click the Open Assign 
Tests button. SiteManager displays the Assign Sample Tests 
window. 

2. Click the More button. SiteManager expands the Assign 
Sample Tests window. 

3. In the Additional Available Tests pane, select the desired 
test. 

4. Click the Add button. SiteManager moves the test to the 
Tests to be Assigned pane. 

5. Click the Save Tests button. 

To remove tests: 

1. On the Basic Sample Data panel, click the Open Assign 
Tests button. SiteManager displays the Assign Sample Tests 
window. 

2. Click the More button. SiteManager expands the Assign 
Sample Tests window. 

3. In the Tests to be Assigned pane, select the desired test. 

4. Click the Remove button. SiteManager moves the test to the 
Additional Available Tests pane. 

5. Click the Save Tests button. 
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Summary 
In this exercise, demonstrate how to assign destination labs and test 
to sample records. 

User ID:  dsawyer Password:  kentucky Connection:  Server 
Group Name:  CENTRAL MATERIALS LAB TECHNICIANS (CMLT) 
Keys:  NA 

1. Open sample 01210DAS090024. 

2. Assign the sample to destination lab Central Office 
Materials. 

3. Remove the ASPHALT EMULSION test. 

4. Were you able to remove the test? Why? _______________ 
_______________________________________________ 

5. Add the SIEVE test. 

6. Save. 

7. Exit SiteManager. 

ANSWERS 

4.  NO. YOU CANNOT 
REMOVE REQUIRED 
TESTS. 



Trns•port SiteManager® and LIMS Training Guide for Kentucky Transportation Cabinet 3-1 

3.  Receiving Samples in Lab Units 

In this chapter, you will receive instruction about the following: 

 Understanding the General Workflow 2 

 Receiving Samples in Lab Units 3 

 Review 11 

 Summary 12 

 



3-2 Receiving Samples in Lab Units 

Understanding the General Workflow 
The following diagram shows the general workflow between SiteManager 
software’s Materials Management and LIMS components. The highlighted 
area denotes the functionality addressed in this chapter. 

Approved
Lists

Material
Information

LIMS

Management Functions

Sampling and Testing

Mix DesignSystem
Administration

Materials Management

 
Figure 3-1.  General Workflow – Receiving Samples in Lab Units – Detail 
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Receiving Samples in Lab Units 
Before you can record test results in LIMS, you must receive the sample in 
a lab unit. 

To denote that a lab unit received the sample, an authorized lab user opens 
the Receive Sample in Lab Unit window and selects the Sample Received 
check box. LIMS removes the sample record from the Receive Sample in 
Lab Unit window and makes the tests assigned to the sample available in 
the Enter Test Results window. 

Usage:  All labs receive samples directly at a lab unit. Most lab users will 
belong to a single lab unit. 

 
Figure 3-2:  SiteManager LIMS - Receive Sample in Lab Unit Window 
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Field Name Description 

Select Lab 
Select to display available tests in queue for a particular 
lab unit to which you belong. 

Filter Criteria Area 
Filter Criteria Select criteria from the dropdown lists and enter text in 

the fields to limit the samples displayed on the window. 
Apply  Click to activate filter criteria entered by the user. 
Reset Click to clear filter criteria.  
Samples to Be Received Area 

Sample Received 

Indicates that a sample has been received at the lab 
unit. Defaults to No. To correctly record the received 
date in LIMS, tester must select the check box when 
receiving the physical sample in the lab unit. 

Sample ID Sample ID to be received. 
Contract ID List of all contracts assigned to the sample. 
Seal Number Seal number for the sample ID. 
Destination 
Receive Date 

Date the destination lab received the sample. Bypassed 
for all samples. This field will be blank. 

Log Date Date the sample was recorded in SiteManager. 
Material Name Description of the material. 
Sample Date Date when the sampler took the sample. 
Geographic Area * Geographic Area where the sample was taken. 
Requested By User ID of the person requesting the sample. 
Sample Date Date when the sample was taken. 
Plant ID Plant ID for the sample. 
P/S Code Producer/Supplier code for the sample. 
Product Name Name of the product for the sample. 
Toolbar Buttons 
Remarks Enter/view remarks associated with the selected sample. 

Document concerns about condition of sample at the 
time it was received if the condition may adversely affect 
testing. Append user ID and date to each remark (user 
ID – mm/dd/yy). 

Table 3-1.  SiteManager LIMS – Receive Sample in Lab Unit Window – Fields 

NOTE 

RECOMMENDED 
FORMAT FOR 
REMARKS: ALL 
CAPS PLUS USER 
ID AND DATE. 



Trns•port SiteManager® and LIMS Training Guide for Kentucky Transportation Cabinet 3-5 

 Exercise 3-1 

In this exercise, learn how to access the Receive Sample in Lab 
Unit window. 

User ID:  llynn Password:  kentucky Connection:  Server 
Group Name:  CENTRAL MATERIALS LAB TECHNICIANS (CMLT) 
Keys:  NA 

1. Start and log on to SiteManager LIMS as user llynn. LIMS 
displays the Navigation Panel window. 

2. Double-click the Receive Sample in Lab Unit icon. LIMS 
displays the Receive Sample in Lab Unit window. 

You’ve accessed the Receive Sample in Lab Unit window. 
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Moving and Resizing Columns 

If desired, change column widths and move locations of the columns on 
the window. 

Note: Once you move or resize a column, it remains in that position until 
you move or adjust it again, even after you exit the window. 

Tip! To move a column, do the following: Click and drag the desired 
column heading to the desired location. Release your mouse button. The 
column displays in the new location. 

Tip! To resize a column, do the following: Position your mouse pointer 
over the line between two columns, click and drag to the desired width. 
Release your mouse button. The column displays with the new width. 

Selecting Labs 

To filter the sample records that display in the Receive Sample in Lab 
Unit window by lab unit, use the Select Lab dropdown list. The Select Lab 
dropdown list contains choices that reflect the lab units assigned to the 
LIMS user. 

Understanding Filter Criteria 

To limit the number of samples displayed or to find a particular sample, 
use the Filter Criteria area.  

Note: The filter is case-sensitive and cannot be built on a previous filter. 

Important! The Filter Criteria dropdown list contains all of the column 
headings. Some column heading descriptions have an asterisk (*) next to 
the field name. An asterisk means that the filter criterion uses the code 
value and not a description. 

The window retains the filter criteria until you click the Reset button. To 
display certain samples each time you open the window, such as samples 
created by yourself, do not reset the filter. 

Understanding Column Headings 

Column headings reflect the fields in the Maintain Sample Information 
window. If necessary, scroll to the right to view all of the available 
columns. 

NOTE 

DEMO THIS. 
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Understanding Sample-Level Remarks 

In the Receive Sample in Lab Unit window, LIMS displays any remarks 
entered for that sample record in SiteManager’s Maintain Sample 
Information window. On each sample record, you can enter, view, or 
modify remarks. 

 Exercise 3-2 

In this exercise, learn how to receive a sample in a lab unit. 

User ID:  llynn Password:  kentucky Connection:  Server 
Group Name:  CENTRAL MATERIALS LAB TECHNICIANS (CMLT) 
Keys:  NA 

1. In the Select Lab dropdown list, verify that the Central 
Office Materials – Aggregate Section choice has been 
selected by default. 

Now, let’s create a filter. 

2. In the first Filter Criteria dropdown list, select the Sample 
ID choice. 

3. In the Filter Criteria text box, type 0001. 

4. Click the Apply button. LIMS selects the 
02214SAM090001 sample record. 

Now, let’s review remarks. 

5. On the toolbar, click the Remarks button. LIMS displays 
remarks entered in the Maintain Sample Information 
window. 

6. In the Remarks field, after any existing remarks, type 
SAMPLE CONTAINER ARRIVED WITH DAMAGE 
(LLYNN - <mm/dd/yy>) 

7. To close the Remarks window, on the toolbar, click the 
Remarks button. 

You’ve reviewed sample-level remarks. 
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 Exercise 3-3 

In this exercise, learn how to receive samples into a lab unit. 

User ID:  llynn Password:  kentucky Connection:  Server 
Group Name:  CENTRAL MATERIALS LAB TECHNICIANS (CMLT) 
Keys:  Central Office Materials – Aggregate Section (lab unit);  
            02214SAM090001 (sample ID) 

1. In the Sample Received column, select the check box. 

2. On the toolbar, click the Save button. LIMS adds the 
sample’s tests to the Enter Test Results queue for the 
Central Office Materials – Aggregate Section unit. 

Now, let’s clear the filter. 

3. In the Filter Criteria area, click the Reset button. 

You’ve received a sample into a lab unit. 
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Receiving a Sample in Multiple Labs 

Some samples have assigned tests that require personnel to perform tests 
in different labs. Each lab unit must receive the sample separately in the 
Receive Sample in Lab Unit window. 

 Exercise 3-4 

In this exercise, receive a sample destined to be received by 
multiple lab units. 

User ID:  llynn Password:  kentucky Connection:  Server 
Group Name:  CENTRAL MATERIALS LAB TECHNICIANS (CMLT) 
Keys:  Central Office Materials – Aggregate Section (lab unit) 

1. In the Select Lab dropdown list, select the D-01 Paducah 
Section choice. 

Now, let’s create a filter. 

2. In the first Filter Criteria dropdown list, select the  
Log Date (mm/dd/yy) choice. 

3. In the second Filter Criteria dropdown list, select the 
Equals choice. 

4. In the Filter Criteria text box, type 01/02/09. 

5. Click the Apply button. LIMS selects the 01312JAN080001 
sample. 

Now, let’s receive the sample for the first lab unit. 

6. In the Sample Received column, select the check box. 

7. On the toolbar, click the Save button. LIMS adds the 
sample’s tests to the Enter Test Results queue for the D-01 
Paducah Section unit. 

NOTE 

MOST LIMS USERS WILL 
BELONG TO A SINGLE 
LAB UNIT. 
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Now, let’s select the second lab unit to receive the sample. 

8. In the Select Lab dropdown list, select the D-01 Materials 
Section choice. 

Now, let’s receive the sample for the second lab unit. 

9. In the Sample ID column, select 01312JAN080001. 

10. In the Sample Received column, select the check box. 

11. On the toolbar, click the Save button. LIMS adds the 
sample’s tests to the Enter Test Results queue for the D-01 
Materials Section unit. 

Now, let’s clear the filter. 

12. In the Filter Criteria area, click the Reset button. 

You’ve received a sample into multiple lab units. 

NOTE 

THE FILTER 
REMAINED IN 
PLACE. 
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Review 
To receive a sample in a lab unit: 

1. On the LIMS panel, double-click the Receive Sample in 
Lab Unit icon. 

2. In the Sample Received column, click to select check box 
for the sample(s) you received. 

3. On the toolbar, click the Save button. 
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Summary 
In this exercise, demonstrate how to receive a sample in a lab unit. 

User ID:  llynn Password:  kentucky Connection:  Server 
Group Name:  CENTRAL MATERIALS LAB TECHNICIANS (CMLT) 
Keys:  D-01 Materials Section (lab unit) 

1. Select the Central Office Materials – Aggregate Section 
lab unit. 

2. Create a filter and apply it to select the 01312JAM090323 
sample record. 

3. Add a remark to state that the sample container was 
damaged. Include user ID and date in the correct format. 

4. Receive the sample in the lab unit. 

5. Save. 

6. Clear the filter. 

7. Exit SiteManager LIMS. 
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4.  Entering Test Results 

In this chapter, you will receive instruction about the following: 

 Understanding the General Workflow 2 

 Entering Test Results 3 

 Understanding Test Statuses 10 

 Handling Requeued Tests 12 

 Handling Retests 14 

 Understanding Test-Level Remarks 16 

 Handling Tests with Assigned Priorities 16 

 Handling Tests with Assigned Testers 16 

 Handling Tests with Assigned Due Dates 16 

 Review 19 

 Summary 20 
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Understanding the General Workflow 
The following diagram shows the general workflow between SiteManager 
software’s Materials Management and LIMS components. The highlighted 
area denotes the functionality addressed in this chapter. 
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Figure 4-1.  General Workflow – Entering Test Results – Detail 
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Entering Test Results 
To access the test templates in which you record test results, use the Enter 
Test Results window. Until you receive the sample in the lab unit, you will 
not see the test in the Enter Test Results queue. 

In the upper pane, each row represents individual tests assigned to a 
sample. When you select a row, the lower pane displays the test template. 
Record the test results in the test template. 

When finished, select the Test Completed check box and click the Save 
button. The system removes the test from the Enter Test Results queue and 
adds the test results to the Review Tests queue for review. 

Note:  As you select different rows, LIMS displays the corresponding test 
templates in the lower pane. 

 
Figure 4-2:  SiteManager LIMS - Enter Test Results Window 

 

NOTE 

INITIALLY, SYSTEM 
SORTS REQUEUES 
AND RETESTS TO THE 
TOP OF THE LIST. 



4-4 Entering Test Results 

Field Name Description 
Test Queue Criteria 
All My Lab Units Select to display available tests in queue for all lab units 

to which you belong. 
Select Lab Select to display available tests in queue for a particular 

lab unit to which you belong. 
Filter Criteria 
Filter Criteria Select criteria from the dropdown lists and enter text in 

the fields to limit the tests displayed on the window. 
Apply  Click to activate filter criteria entered by the user. 
Reset Click to clear filter criteria.  
Test to Be Completed Area 
Test Completed Indicate that a sample test is complete. Select check box 

when the test is ready for review. 
Sample ID Identifies sample. 
Lab Control 
Number 

An umbrella number used to link samples. May use 
during sample review to process multiple samples at 
once. 

Lab Reference 
Number 

Simplified sample identifier used in the labs. 

Seal Number Seal number on the batch of the material tested. 
Control Number Actual number for the type of control to identify the 

sample. 
Contract ID Identifies the contract. 
Test Description Describes the test method. 
Test Number Indicates run of the test on the sample. 
Test Started Indicates whether tester has started test. Select the 

check box when the test has begun. Save. 
Tester * Tester assigned by the supervisor to perform or oversee 

the test. Optional. 
Test Status * Current status of the test. If Requeued or Retest 

Ordered, perform these tests before others in the queue. 
Priority Priority assigned to the test by the supervisor. Defaults 

to Medium. Optional. 
Due Date Due date assigned to the test by the supervisor. 

Optional. 
Sample Type * Indicates type of sample. 
Material Code Identifies the material. 
Lab Unit Indicates where the test will be performed. 
Sampler User ID of the person who took the sample. 
Producer Supplier* Producer/supplier of the material in the sample. 
Receive Date Date when the sample was received in the lab unit. 
Manufacturer * Manufacturer of the material in the sample. 
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Field Name Description 
Sample Date Date the sampler took the sample. 
Effective Date Identifies date of specification selected for checks 

against the test template. 
Toolbar Buttons 
Remarks Enter/View remarks associated with the selected test. 

Record all remarks for the test into the appropriate 
internal or public remarks type. 
Internal – Remarks intended for KYTC lab personnel. 
Users with access to the following windows have access 
to these internal remarks: 

 SiteManager Maintain Sample Information 
window’s Tests panel 

 LIMS Enter Test Results 
 LIMS View-Only Sample Information window’s 

Test Status panel 
 LIMS Maintain Test Queue 

Public – Remarks intended to be displayed for KYTC 
personnel and printed on reports for external use. 

Add Testers Click to open the Add Testers window. Add testers to the 
selected test. If you edit the test results, LIMS 
automatically adds your name to the Add Testers 
window’s ‘Testers already assigned to the sample’ pane. 
If entering data on behalf of a tester, select the name of 
the tester who performed the test. Record the names of 
all testers. 

Table 4-1.  SiteManager LIMS - Enter Test Results Window – Fields 

 Exercise 4-1 

In this exercise, learn to open the Enter Test Results window. 

User ID:  wjudd Password:  kentucky Connection:  Server 
Group Name:  CENTRAL MATERIALS LAB TECHNICIANS (CMLT) 
Keys:  NA 

1. Start and log on to SiteManager LIMS as user wjudd. LIMS 
displays the Navigation Panel window. 

2. Double-click the Enter Test Results icon. LIMS displays 
the Enter Test Results window. 

You’ve accessed the Enter Test Results window. 



4-6 Entering Test Results 

Selecting Labs 

The Test Queue Criteria area contains both the All My Lab Units and the 
Select a Lab Unit buttons. Your selection determines if LIMS displays the 
tests in all lab units assigned to you or tests in an individual lab unit 
assigned to you. 

Understanding Filter Criteria 

To help define data displayed on the window, the Filter Criteria dropdown 
list has the additional fields from the Enter Test Results window available 
for you to choose. 

Determining Available Tests with Contract Authority 

Note:  LIMS displays only the samples assigned to your lab unit(s). 

If a tester does not have contract authority, then LIMS does not display the 
test on the Enter Test Results queue even if the test is assigned to the lab 
unit to which the user belongs. 

 
Figure 4-3:  SiteManager LIMS - Enter Test Results Window (filter applied) 
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 Exercise 4-2 

In this exercise, learn how to view tests in the tester’s queue. 

User ID:  wjudd  Password:  kentucky Connection:  Server 
Group Name:  CENTRAL MATERIALS LAB TECHNICIANS (CMLT) 
Keys:  D-01 Paducah Section (lab unit) 

1. In the Test Queue Criteria area, in the Select a Lab Unit 
dropdown list, select the Central Office Materials – 
Liquid Asphalt Section choice. 

Now, let’s apply a filter. 

2. In the first Filter Criteria dropdown list, select the 
Contract ID choice. 

3. In the second Filter Criteria dropdown list, select the 
Equals choice. 

4. In the Filter Criteria text box, type 061043. 

5. Click the Apply button. LIMS selects the ASPHALT 
BINDER test for sample 012130JTG09734. LIMS displays 
the test template in the lower pane. 

You’ve viewed the list of tests available for the selected contract. 



4-8 Entering Test Results 

Understanding Material Test Templates 

To record test results, use material test templates. When you select a test 
row in the upper pane, then LIMS displays the material test template in the 
lower pane. 

To compare test results against specification requirements, some tests use 
a material test specification with a minimum and maximum value range. 
Since this material specification can change over time, select the desired 
specification by effective date. 

 
Figure 4-4:  SiteManager LIMS - Enter Test Results Window - Test Data – Detail 
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 Exercise 4-3 

In this exercise, learn how to enter test results. 

User ID:  wjudd  Password:  kentucky Connection:  Server 
Group Name:  CENTRAL MATERIALS LAB TECHNICIANS (CMLT) 
Keys:  Central Office Materials – Liquid Asphalt Section (lab unit) 

1. In the Test Data window, click the Maximize button. LIMS 
displays the enlarged window. 

Now, let’s record the test data. 

2. In the Bottle 1 column for the Weight before oven aging 
field, type 202.7295. 

3. In the Bottle 1 column for the Weight after oven aging 
field, type 202.7034. 

4. In the Bottle 2 column for the Weight before oven aging 
field, type 205.8535. 

5. In the Bottle 2 column for the Weight after oven aging 
field, type 205.8265. 

6. In the Original Dynamic Shear (T 315) * field, type 3.12. 

7. In the RTFO Dynamic Shear (T 315) * field, type 6.04. 

8. In the PAV Dynamic Shear (T 315) * field, type 3818. 

9. In the BBR m-Value (T 313) * field, type 0.322. 

10. In the BBR stiffness (T 313) * field, type 164. 

11. On your keyboard, press the Tab key. SiteManager 
calculates the fields. 

12. In the Template Status dropdown list, select the In Spec 
choice. 

13. In the Test Data window, on the title bar, click the Restore 
Down button. LIMS restores the window. 

Now, let’s save the test data. 

14. On the toolbar, click the Save button. 

NOTE 

PRESS THE TAB KEY 
TO MOVE FROM 
FIELD-TO-FIELD AND 
TO CALCULATE THE 
VALUES. 

WHEN VALUES ARE IN 
SPEC, THE LABEL 
TURNS FROM RED 
TEXT WITH AN 
ASTERISK TO BLACK 
TEXT WITHOUT AN 
ASTERISK. 



4-10 Entering Test Results 

Now, let’s mark the test as complete. 

15. In the upper pane, in the Test Completed column, select the 
check box. 

16. On the toolbar, click the Save button. LIMS removes the 
test from the queue. 

17. To clear the filter, in the Filter Criteria area, click the 
Reset button. LIMS displays the remaining tests in the 
queue for this technician in this lab unit. 

You’ve completed a test. 

Understanding Test Statuses 
After you mark a test as complete, LIMS makes the test available for 
review in the Review Tests window.  

LIMS changes the test status and test number depending on where the test 
is in the LIMS workflow. Use test statuses to understand the actions 
performed on a test and to monitor where the test is in the LIMS 
workflow. Depending on the test status, the test will appear in different 
queues. 

See also: Maintaining Test Queues 
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Code and Test Status Description 
0 - Test Canceled  Appears in Maintain Test Queue window 

only. 
 No modifications allowed. 

01 - Test Initialization  Appears only in windows available to the 
system administrator. 

05 - Test Assigned  Appears in Maintain Test Queue window. 
10 - Test in Queue  Appears in Enter Test Results window. 

 Appears in Maintain Test Queue window. 
 New test in the queue. 
 Test number is one. 

11 - Requeued  Appears in Enter Test Results window. 
 Appears in Maintain Test Queue window. 
 Sent back to tester. 
 Test number is one. 

20 - Was Retested  Appears in Enter Test Results window. 
 Appears in Maintain Test Queue window. 
 Ordered another test. 
 Test number will be two or higher if other 

retests are ordered. 
21 - Retest Ordered  Appears in Enter Test Results window. 

 Appears in Maintain Test Queue window. 
 Reordered original test. 
 Test Number is one. 
 No modifications allowed. 

40 - Test Completed  Appears in Review Tests window. 
 Appears in Maintain Test Queue window. 
 No modifications allowed. 

50 - Revwd by Line Supvsr  Appears in Maintain Test Queue window. 
60 - Test Approved by Lab 
Supervisor 

 Appears in Maintain Test Queue window. 

80 - Finalized  Appears only in windows available to the 
system administrator. 

81 - Back to Lab  Appears in Review Tests window. 
 Appears in Maintain Test Queue window. 
 If other tests were associated to the 

sample, then all linked tests will appear 
back in the Maintain Test Queue window 
with a test status of 60 – Test Approved 
by Lab Supervisor. 

Table 4-2.  SiteManager LIMS - Test Statuses (as defined for training) 

NOTE 

CODES IN TRAINING MAY 
NOT MATCH THOSE IN 
PRODUCTION. 



4-12 Entering Test Results 

Handling Requeued Tests 
When a tester receives a requeued test, the tester should re-examine the 
test results. Requeued tests always appear at the top of the Enter Test 
Results queue. 

 Exercise 4-4 

In this exercise, learn how to handle a requeued test. 

User ID:  wjudd Password:  kentucky Connection:  Server 
Group Name:  CENTRAL MATERIALS LAB TECHNICIANS (CMLT) 
Keys:  Central Office Materials – Liquid Asphalt Section (lab unit) 

1. At the top of the Test Status column, select the  
11 – Requeued test. 

Now, let’s review the remarks. 

2. On the toolbar click the Remarks button. LIMS displays the 
remarks window. 

3. To see why the test was requeued, click the  
Requeue Comments remark type. 

4. To close the remarks window, on the toolbar, click the 
Remarks button again. 

Now, let’s examine the values and make any necessary changes. 

5. In the Test Data window, click the Maximize button. LIMS 
displays the enlarged window. 

6. In the BBR m-Value (T 313) * field, type 0.322. 

7. On your keyboard, press the Tab key. 

8. In the Test Data window, on the title bar, click the Restore 
Down button. LIMS restores the window. 

9. On the toolbar, click the Save button. 

NOTE 

DO NOT REMOVE 
COMMENTS; APPEND 
TO THEM. 
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Now, let’s add a remark. 

10. On the toolbar click the Remarks button. LIMS displays the 
remarks window. 

11. Click the Requeue Comments remark type. 

12. In the Requeue Comments field, type CORRECTED 
THE MIS-KEYED VALUE. (WJUDD – < mm/dd/yy >) 

13. To close the remarks window, on the toolbar, click the 
Remarks button again. 

Now, let’s mark the test as complete. 

14. In the Test Completed column, select the check box. 

15. On the toolbar, click the Save button. LIMS removes the 
ASPHALT BINDER test for sample 01314HAN090003 
from the test queue. 

You’ve reviewed remarks and corrected an incorrect value on a 
requeued test. 



4-14 Entering Test Results 

Handling Retests 
When a tester receives an order for a retest, the tester must perform the 
test again on the new test record that LIMS has linked to the sample and 
displayed in the Enter Test Results window. The original test number will 
not display in the Enter Test Results window. Retests always appear at the 
top of the Enter Test Results queue. 

 Exercise 4-5 

In this exercise, learn how to enter test results on a reordered test. 

User ID:  wjudd Password:  kentucky Connection:  Server 
Group Name:  CENTRAL MATERIALS LAB TECHNICIANS (CMLT) 
Keys:  Central Office Materials – Liquid Asphalt Section (lab unit) 

1. At the top of the Test Status column, select the  
21 – ReTest Ordered test. 

Now, let’s review the remarks. 

2. On the toolbar click the Remarks button. LIMS displays the 
remarks window. 

3. To see why the test was ordered again, click the  
Retest Comments remark type. 

4. To close the Remarks window, on the toolbar, click the 
Remarks button again. 

Now, let’s enter the values of the new test. 

5. In the Test Data window, click the Maximize button. LIMS 
displays the enlarged window. 

6. In the Bottle 1 column for the Weight before oven aging 
field, type 202.7295. 

7. In the Bottle 1 column for the Weight after oven aging 
field, type 202.7034. 

8. In the Bottle 2 column for the Weight before oven aging 
field, type 205.8535. 
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9. In the Bottle 2 column for the Weight after oven aging 
field, type 205.8265. 

10. In the Original Dynamic Shear (T 315) * field, type 3.12. 

11. In the RTFO Dynamic Shear (T315) * field, type 6.04. 

12. In the PAV Dynamic Shear (T315) * field, type 3818. 

13. In the BBR m-Value (T 313) * field, type 0.322. 

14. In the BBR stiffness (T313) * field, type 164. 

15. On your keyboard, press the Tab key. SiteManager 
calculates the fields. 

16. In the Template Status dropdown list, select the In Spec 
choice. 

17. In the Test Data window, on the title bar, click the Restore 
Down button. LIMS restores the window. 

18. On the toolbar, click the Save button. 

Now, let’s add a remark. 

19. On the toolbar click the Remarks button. LIMS displays the 
remarks window. 

20. Click the Retest Comments remark type. 

21. In the Retest Comments field, type RETEST PASSED. 
(WJUDD - < mm/dd/yy >) 

22. To close the Remarks window, on the toolbar, click the 
Remarks button again. 

Now, let’s mark the test as complete. 

23. In the Test Completed column, select the check box. 

24. On the toolbar, click the Save button. LIMS removes the 
ASPHALT BINDER test for the 01312SHJ090004 sample 
from the queue. 

You’ve reviewed remarks and entered values for a retest. 



4-16 Entering Test Results 

Understanding Test-Level Remarks 
Remarks available from the Enter Test Results window include both 
internal lab remarks and public remarks. 

Only qualified lab personnel can enter and view the internal lab remarks in 
the Enter Test Results, Review Tests, and Maintain Test Queue windows. 

All users may use the View-Only Sample Information window to view 
public remarks. 

Handling Tests with Assigned Priorities 
LIMS assigns a default test priority of Medium to tests. If you encounter a 
High or Low priority in the Priority column, you can use the status to 
manage your test completion order. Tests with a High priority sort to the 
top of the Enter Test Results window immediately after any retests or 
requeued tests. 

Important!  LIMS does not display a warning if you perform a test with a 
lower priority before you perform tests with a High priority. 

Handling Tests with Assigned Testers 
If you encounter a test with an assigned tester in the Tester column, only 
the specified tester should perform the test. 

Important!  LIMS does not restrict testers other than the specified tester 
from performing the test. All qualified testers in that lab unit will continue 
to have access to that test. 

Usage:  Labs will enforce a business rule that if a supervisor assigns a 
tester to a test, the supervisor expects that tester to complete the test. 

Handling Tests with Assigned Due Dates 
If you encounter a test with an assigned due date in the Due Date column, 
try to perform the test before the specified date. 

Important!  LIMS does not display a message to warn you if you do not 
perform the test before the due date. 

IMPORTANT 

THERE IS NO WARNING IF 
THE DUE DATE PASSES. 

NOTE 

REMEMBER TO ADD 
USER ID AND DATE 
AFTER EACH 
COMMENT. 
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 Exercise 4-6 

In this exercise, learn how to enter test results on a test assigned a 
due date, add an internal remark, and add a tester. 

User ID:  wjudd Password:  kentucky Connection:  Server 
Group Name:  CENTRAL MATERIALS LAB TECHNICIANS (CMLT) 
Keys:  Central Office Materials – Liquid Asphalt Section (lab unit) 

1. In the first Filter Criteria dropdown list, select the  
Due Date (mm/dd/yy) choice. 

2. In the second Filter Criteria dropdown list, select the 
Equals choice. 

3. In the Filter Criteria text box, type 01/27/09. 

4. Click the Apply button. LIMS selects the 
01210DAA090478 sample record. 

Now, let’s answer a couple questions. 

5. What is the priority? _____________  

6. To whom did the supervisor assign this test? ___________  

Now, let’s add an internal remark. 

7. On the toolbar, click the Remarks button. LIMS displays 
the Remarks window. 

8. In the Internal Comments field, type JDAVIS 
RECORDED RESULTS ON PAPER. ADDED JDAVIS 
AS TESTER. (WJUDD - < mm/dd/yy >) 

9. To close the Remarks window, on the toolbar, click the 
Remarks button again. 

10. On the toolbar, click the Save button. 

ANSWERS 

5.  HIGH 

6.  WJUDD 



4-18 Entering Test Results 

Now, let’s add a tester. 

11. On the toolbar, click the Add Testers button. LIMS 
displays the Add Testers window. 

12. In the Additional testers available for assignment pane, in 
the Tester column, select jdavis. 

13. Click the Add button. LIMS moves the tester to the Testers 
already assigned to the sample pane. 

14. Click the OK button. LIMS closes the Add Testers window 
and displays the Enter Test Results window. 

Now, let’s mark the test as complete. 

15. In the Test Completed column, select the check box. 

16. On the toolbar, click the Save button. LIMS removes the 
test from the queue. 

17. To clear the filter, click the Reset button. 

You’ve entered test results on a test assigned a due date, added an 
internal remark, and added a tester. 
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Review 
To enter test results: 

1. On the LIMS panel, double-click the Enter Test Results 
icon. 

2. Select the sample’s test row. 

3. Enter the test results for the test. 

4. In the Test Completed column, click to select the check 
box for the sample you are marking complete. 

5. On the toolbar, click the Save button. 

To add testers: 

1. On the toolbar, click the Add Testers button. 

2. In the Additional testers available for assignment pane, in 
the Tester column, select the desired tester. 

3. Click the Add button. LIMS moves the tester to the Testers 
already assigned to the sample pane. 

4. Click the OK button. 



4-20 Entering Test Results 

Summary 
In this exercise, demonstrate how to handle a requeued test, add a 
tester, enter test results for multiple tests, and mark test results as 
test complete. 

User ID:  wjudd Password:  kentucky Connection:  Server 
Group Name:  CENTRAL MATERIALS LAB TECHNICIANS (CMLT) 
Keys:  Central Office Materials – Liquid Asphalt Section (lab unit) 

1. Select the D-01 Paducah Section lab unit. 

2. How many tests are associated to sample 
01210GAH090045 in this window? ___________ 

3. Why has the CONCRETE CYLINDER STRENGTH test 
been requeued? __________________________________ 

4. In the Load field that displays 3417 lbs, change the value to 
53417 lbs. 

5. Add a remark that it was corrected. 

6. Mark the test as complete. 

7. Save. 

8. For the CONCRETE PLASTIC TESTS test on sample 
01210GAH090045, continue the testing for gclooney since 
he is not at work today and the test has a High priority. In 
the Concrete Temperature KM 64-318 area, in the 
Temperature field, type 83. In the Technician field, type 
wjudd. 

9. Save. 

10. View the Add Testers window. 

11. Did LIMS automatically add wjudd as a tester? _________ 

12. Mark the test as complete. 

13. Save. 

14. Exit SiteManager LIMS. 

 

ANSWERS 

2.  2 

3.  NEED TO VERIFY LOAD 
VALUES. 

11.  YES 
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5.  Reviewing Tests 

In this chapter, you will receive instruction about the following: 

 Understanding the General Workflow 2 

 Reviewing Tests 3 

 Autofinalizing Samples 12 

 Review 13 

 Summary 15 

 



5-2 Reviewing Tests 

Understanding the General Workflow 
The following diagram shows the general workflow between SiteManager 
software’s Materials Management and LIMS components. The highlighted 
area denotes the functionality addressed in this chapter. 

Approved
Lists

Material
Information

LIMS

Management Functions

Sampling and Testing

Mix DesignSystem
Administration

Materials Management

 
Figure 5-1.  General Workflow – Reviewing Tests – Detail 
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Reviewing Tests 
To review the test results submitted by the tester, use the Review Tests 
window. 

Note: Not all tests assigned to a sample have to be marked complete in the 
Enter Test Results window before the completed tests will appear in the 
Review Tests window. 

 
Figure 5-2.  SiteManager LIMS - Review Tests Window – Single Test Result View 



5-4 Reviewing Tests 

 

Field Name Description 
Test Queue Criteria 
All My Lab Units Select to display available tests in queue for all lab 

units to which you belong. 
Select a Lab Unit Select to display available tests in queue for a 

particular lab unit to which you belong. 
Filter Criteria 
Filter Criteria Select criteria from the dropdown lists and enter 

text in the fields to limit the tests displayed on the 
window. 

Apply  Click to activate filter criteria entered by the user. 
Reset Click to clear filter criteria.  
Columns 
Supervisor Action Reviewer selects the following actions to take on 

the test:  
 Review Completed – Indicates the test 

results have been reviewed and are ready 
to proceed to the Review Sample window.  

 Requeue – Indicates the test results 
should be re-examined by the tester. 
Detailed info about the request should be 
found in the Remarks window’s Requeue 
Comments remark type. 

 Order Retest – Indicates the test should be 
performed again (max of 5). Detailed info 
about the request should be found in the 
Remarks window’s Retest Comments 
remark type. 

Reportable Indicates whether the test is reportable. Do not 
clear. 

Lab Control Number An umbrella number used to link samples. May use 
during sample review to process multiple samples 
at once. 

Lab Reference Number Simplified sample identifier used in the labs. 
Sample ID Identifies the sample. 
Contract ID List of all contracts assigned to the sample. 
Test Description Describes the test method. 
Test Number Indicates run of the test on the sample. 
Test Status * Current status of the test. 
Tester * Tester assigned by the supervisor to perform or 

oversee the test. 
Completed Date Date when the sample was marked as complete in 

the lab unit. 
Priority Priority assigned to the test by the supervisor. 
Due Date Due date assigned to the test by the supervisor. 



Trns•port SiteManager® and LIMS Training Guide for Kentucky Transportation Cabinet 5-5 

Field Name Description 
Material Code Identifies the material. 
Producer Supplier * Producer/supplier of the material in the sample. 
Manufacturer * Manufacturer of the material in the sample. 
Sampler User ID of the sampler. 
Test Method Method used to test material. 
Sample Type* Indicates type of sample. 
Control Number Actual number for the type of control to identify the 

sample. 
Seal Number Seal number on the batch of the material tested. 
Sample Date Date the sampler took the sample. 
Toolbar Buttons 
Remarks Enter/View remarks associated with the selected 

test. Enter appropriate remarks for retest and 
requeue. 

Table 5-1.  SiteManager LIMS – Review Tests Window – Fields 

 Exercise 5-1 

In this exercise, learn how to access the Review Tests window. 

User ID:  gclooney Password:  kentucky Connection:  Server 
Group Name:  CENTRAL MATERIALS LAB MANAGERS (CMLM) 
Keys:  All My Lab Units (lab unit) 

1. Start and log on to SiteManager LIMS as user gclooney. 
LIMS displays the Navigation Panel window. 

2. Double-click the Review Tests icon. LIMS displays the 
Review Tests window. 

You’ve accessed the Review Tests window. 

NOTE 

FOR TRAINING 
PURPOSES, THIS USER 
BELONGS TO MULTIPLE 
LAB UNITS. 



5-6 Reviewing Tests 

Selecting Labs 

To display tests from all of your assigned lab units or a selected assigned 
lab unit, click the appropriate button in the Test Queue Criteria area. 

Viewing Results for a Single Test 

When you select a test in the upper pane, the Test Results pane displays 
the test results in a view-only format for a single test. 

Viewing Results for Multiple Tests on the Same Template 

To compare test results entered into the same test template for tests 
performed on several different samples, select any row with the desired 
test. Click the Multi-Test test result view button. LIMS displays only the 
rows matching the selected test template for all samples with tests to 
review. Then, select the specific tests to compare. Click the Compare 
Results button. LIMS displays a table in the Test Results pane to compare 
results of the same test performed across samples. 

 
Figure 5-3.  SiteManager LIMS - Review Tests Window - Multi-Test Result View 

 

Field Name Description 
Test Template Test template for which the comparison is being made. 
Template Column Field on the template. 
Min Minimum acceptable value for a spec template. 
Max Maximum acceptable value for a spec template. 
Sample ID / Test 
Number 

Combination of Sample ID and the sample test number 
selected for the grid view results comparison. 

Table 5-2.  SiteManager LIMS – Review Tests Window – Multi-Test Test Result 
View – Fields 

NOTE 

EXPAND COLUMN WIDTH. 

EXPLAIN TEST NUMBER 
FORMAT…‘/1’ 
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 Exercise 5-2 

In this exercise, learn how to review test results for single tests and 
multiple tests. 

User ID:  gclooney Password:  kentucky Connection:  Server 
Group Name:  CENTRAL MATERIALS LAB MANAGERS (CMLM) 
Keys:  All My Lab Units (lab unit) 

1. In the Sample ID column, select 01314JES093456. LIMS displays 
the test results for the CEMENT TEST in the lower pane. 

Now, let’s review results for a single test. 

2. In the Test Results pane, on the title bar, click the 
Maximize button. 

3. Review the test results. 

4. In the Test Results pane, on the title bar, click the Restore 
Down button. 

Now, let’s review results for multiple tests. 

5. In the Test Result Views area, click the Multi-Test button. 
LIMS displays only the tests that match the selected test 
description. 

6. Select all tests. 

7. Click the Compare Results button. The system displays test 
results for all CEMENT TEST tests in the review tests queue. 

8. In the Test Results pane, on the title bar, click the 
Maximize button. 

9. Review the test results. 

Now, let’s prepare for the next exercise. 

10. In the Test Results pane, on the title bar, click the Restore 
Down button. 

11. In the Test Result Views area, click the Single Test button. 

You’ve reviewed test results. 

TIP! 

‘CTRL + CLICK’ OR  
‘SHIFT + CLICK’ TO 
SELECT MORE THAN ONE 
TEST AT A TIME.  

TIP! 

FOR CONVENIENCE, 
MOVE TEST 
DESCRIPTION COLUMN 
NEXT TO SAMPLE ID 
COLUMN. 



5-8 Reviewing Tests 

Acting on Test Results 

To determine where the test moves in the LIMS workflow based on your 
review, select the appropriate action from the Supervisor Action dropdown 
list for each test. Choices include Review Completed, Requeue, or Order 
Retest. 

Indicating that Results are Acceptable for Evaluation 

To indicate that the test results are acceptable to evaluate in the Review 
Samples window, select the Reportable check box. 

Note:  By default, LIMS selects the Reportable check box. 

Warning! If you clear the Reportable check box, the test results for the 
associated test will not appear in the Review Samples window and reports. 
If cleared, the test results will continue to display in the View-Only 
Sample Information and the Maintain Test Queue windows. 

 Exercise 5-3 

In this exercise, learn how to mark tests as complete. 

User ID:  gclooney Password:  kentucky Connection:  Server 
Group Name:  CENTRAL MATERIALS LAB MANAGERS (CMLM) 
Keys:  All My Lab Units (lab unit) 

1. In the Test Queue Criteria area, click the Select a Lab 
Unit button. LIMS has ‘Central Office Materials-
Concrete/Cement Section’ selected by default. 

2. In the Test Description column, select CEMENT TEST 
for sample 01314JES093456. 

3. In the Supervisor Action dropdown list, select the  
Review Completed choice. 

4. On the toolbar, click the Save button. LIMS removes the 
test from the Review Tests queue and sends it to the Review 
Samples queue. 

You’ve marked a test as complete. 
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Requeueing Tests 

If you want the tester to re-examine the submitted test results, then select 
the Requeue choice from the Supervisor Action dropdown list. Add a 
remark to provide a reason why the tester should reexamine the results. 

Requeueing a test returns the test to the Enter Test Results queue. In the 
Enter Test Results window, the test has a test status of ‘Requeue’ with a 
test number of ‘1.’ 

Review Tests Review SamplesEnter Test Results

SiteManager LIMS: Requeue Test Workflow
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Sample
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All
tests

completed

Test C (Run 1) -
Test in Queue (10) /

Requeued (11)

Test(s)
Completed (40)

Test(s)
Approved (60)

Section
Supervisor or Lab

Manager
Tester

Requeued (11)

Section
Supervisor

Sample(s)
Authorized (80)

Received In Testing Pre-authorizationLogged Complete

Receive Sample
in Destination

Lab

Maintain
Sample

Information

Pending

Assign
Tests

Sample
Sample

with 1 Test
(1 Run)

Sample
with 1 Test

(1 Run)

 
Figure 5-4.  Requeue Test Workflow 
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 Exercise 5-4 

In this exercise, learn how to requeue a test. 

User ID:  gclooney Password:  kentucky Connection:  Server 
Group Name:  CENTRAL MATERIALS LAB MANAGERS (CMLM) 
Keys:  Central Office Materials-Concrete/Cement Section (lab unit) 

1. In the Test Description column, select CEMENT TEST 
for sample 01314MAN096756. 

2. In the Supervisor Action dropdown list, select the 
Requeue choice. LIMS automatically displays the Remarks 
window. 

3. Click the Requeue Comments remark type. 

4. In the Requeue Comments field, type COMPRESSIVE 
STRENGTH IS TOO HIGH, PLEASE CHECK 
NUMBERS. (GCLOONEY - <mm/dd/yy>) 

5. To close the Remarks window, on the toolbar, click the 
Remarks button. 

6. On the toolbar, click the Save button. LIMS removes the 
test from the queue. 

You’ve requeued a test. 

CAUTION! 

SELECT THE DESIRED 
REMARK TYPE. LIMS 
SELECTS THE ‘INTERNAL 
COMMENTS’ REMARK 
TYPE BY DEFAULT. 
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Ordering Retests 

If you want the tester to perform a test again, then the reviewer selects the 
Order Retest choice from the Supervisor Action dropdown list. Add a 
remark to provide a reason why the tester should perform the test again. 

Ordering a retest links a new test to the sample and displays that test in the 
Enter Test Results queue. In the Enter Test Results window, the test has a 
test status of ‘Retest Ordered’ and a test number of ‘2’ or more depending 
on the number of test runs already on the sample. 

Review Tests Review SamplesEnter Test Results
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 Retest in Queue (20)
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Figure 5-5.  Order Retest Workflow 
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 Exercise 5-5 

In this exercise, learn how to order a retest. 

User ID:  gclooney Password:  kentucky Connection:  Server 
Group Name:  CENTRAL MATERIALS LAB MANAGERS (CMLM) 
Keys:  Central Office Materials-Concrete/Cement Section (lab unit) 

1. In the Test Description column, select CEMENT TEST 
for sample 01214SMC095678. 

2. In the Supervisor Action dropdown list, select the Order 
Retest choice. LIMS automatically prompts you to add 
additional runs. 

3. In the Select Additional Runs dropdown list, to accept the 
default of 1, click the OK button. LIMS automatically 
displays the Remarks window. 

4. Click the Retest Comments remark type. 

5. In the Retest Comments field, type PERFORM TEST 
AGAIN. NUMBERS ARE MUCH HIGHER THAN 
SPECS WILL ALLOW. (GCLOONEY - <mm/dd/yy>) 

6. To close the Remarks window, on the toolbar, click the 
Remarks button. 

7. On the toolbar, click the Save button. LIMS removes the 
test from the queue. 

You’ve ordered a retest. 

Auto-Finalizing Samples 
After the test reviewer approves a test, LIMS first checks to see if all other tests 
for the sample meet specification limits or have no specification limits, and then 
LIMS checks to verify if those tests have been selected to auto-finalize.  

If the tests meet these criteria, LIMS bypasses the Review Samples 
window and assigns a sample status of Completed to the sample. If the 
tests do not meet these criteria, LIMS handles the sample like all other 
samples not set to auto-finalize. 

Usage:  Per KYTC policy, all certification samples are set to auto-finalize. 
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Review 
To open the Review Tests window: 

1. On the Navigation Panel, double-click the Review Tests 
icon. 

To mark a test as complete: 

1. On the Review Tests window, select a test. 

2. In the Supervisor Action dropdown list, select the Review 
Complete choice. 

3. Click the Save button. 

To mark a test as reportable: 

1. On the Review Tests window, select a test. 

2. In the Reportable column, select the check box. 

To compare multiple tests: 

1. In the Test Description column, select the desired test. 

2. In the Test Result Views area, click the Multi-Test button. 
LIMS displays only the tests that match the selected test 
description. 

3. Select all desired tests to compare. 

4. Click the Compare Results button. 

5. Review the test results. 

To maximize the Test Results pane: 

1. In the Test Results pane’s title bar, click the Maximize 
button. 

To minimize the Test Results pane: 

1. In the Test Results pane’s title bar, click the Restore Down 
button. 
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To requeue a test: 

1. On the Review Tests window, select a test.  

2. In the Supervisor Action dropdown list, select the 
Requeue choice. 

3. Click the Save button. 

To order a retest: 

1. On the Review Tests window, select a test.  

2. In the Supervisor Action dropdown list, select Order 
Retest. 

3. Click the Save button. 
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Summary 
In this exercise, demonstrate how to review tests in the Review 
Tests window. 

User ID:  gclooney Password:  kentucky Connection:  Server 
Group Name:  CENTRAL MATERIALS LAB MANAGERS (CMLM) 
Keys:  Central Office Materials-Concrete/Cement Section (lab unit) 

1. Compare multiple tests for the ASPHALT BINDER test. 

2. Mark the ASPHALT BINDER test for sample 
01314GCC090023 as Review Completed. 

3. Requeue the ASPHALT BINDER test for sample 
01314GCC093232. Add a remark to double-check the m-Value. 

4. Order a retest with two runs of the ASPHALT BINDER 
test for sample 01314GCC097365. Add a comment that the 
values are very out of spec. 

5. Return to single test view. 

6. Exit SiteManager LIMS. 



5-16 Reviewing Tests 
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6.  Maintaining Test Queues 

In this chapter, you will receive instruction about the following: 

 Understanding the General Workflow 2 

 Maintaining Test Queues 3 

 Review 13 

 Summary 15 

 



6-2 Maintaining Test Queues 

Understanding the General Workflow 
The following diagram shows the general workflow between SiteManager 
software’s Materials Management and LIMS components. The highlighted 
area denotes the functionality addressed in this chapter. 

Approved
Lists

Material
Information

LIMS

Management Functions

Sampling and Testing

Mix DesignSystem
Administration

Materials Management

 
Figure 6-1.  General Workflow – Maintaining Test Queues – Detail 
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Maintaining Test Queues 
To monitor tests and test statuses as the tests move in the LIMS workflow, 
use the Maintain Test Queue window. 

The Maintain Test Queue window displays all tests for samples from the 
time they have been received until all tests have been reviewed and 
completed. 

The Maintain Test Queue window provides flexibility for monitoring 
tests: 

 Add/cancel tests on samples. 

 Assign due dates to tests. 

 Assign priorities to tests. 

 Appoint individual testers to tests. 

 Assign tests to different lab units. 

When you select a test, LIMS displays the Lab ID and Lab Name assigned 
to the test in the lower pane. 

 
Figure 6-2.  SiteManager LIMS - Maintain Test Queue Window 

 

NOTE 

IMPORTANT TO SEE 
WHAT IS GOING ON IN 
THE LAB. CAN SEE 
TEST STATUS FROM 
RECEIVING TO 
REVIEWING. 



6-4 Maintaining Test Queues 

Field Name Description 
Test Queue Criteria 
All My Lab Units Select to display available tests in queue for all lab 

units to which you belong. 
Select a Lab Unit Select to display available tests in queue for a 

particular lab unit to which you belong. 
Filter Criteria 
Filter Criteria Select criteria from the dropdown lists and enter 

text in the fields to limit the tests displayed on the 
window. 

Apply  Click to activate filter criteria entered by the user. 
Reset Click to clear filter criteria.  
Column Headings 
Sample ID Identifies the sample. 
Contract ID List of all contracts assigned to the sample. 
Lab Control Number An umbrella number used to link samples. May use 

during sample review to process multiple samples 
at once. 

Lab Reference Number Simplified sample identifier used in the labs. 
Seal Number Seal number on the batch of the material tested. 
Test Description Describes the test method. 
Test Number Indicates run of the test on the sample. 
Receive Date Date the lab unit received the sample. 
Priority Assign priority to the test. Defaults to Medium. 

Optional. 
Due Date Assign date by which the tester should complete 

the test. 
Tester * User ID of the tester. 
Material Name Name assigned to the material in the sample. 
Test Status * Current status of the test. 
Product Name Brand name of the material in the sample. 
Sample Type * Indicates type of sample. 
Lower Pane 
Lab ID Change labs for tests only if a destination lab was 

improperly assigned to the sample. 
Charge Amount Per KYTC policy, this field will not be used. 
Start Date When the tester first entered test results. 
Actual Completion Date Tester populated with the actual date the test was 

completed. Required for authorization. 
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Field Name Description 
Toolbar Buttons 
Remarks Enter/View remarks associated with the selected 

test.  
Cancel Test Cancel the selected test if it was improperly 

assigned to a sample. 
Add Test Add a new test or additional test runs to the 

selected sample. 

Table 6-1.  SiteManager LIMS – Maintain Test Queue Window – Fields 

 Exercise 6-1 

In this exercise, learn how to access the Maintain Test Queue window. 

User ID:  dhines Password:  kentucky Connection:  Server 
Group Name:  DISTRICT MATERIALS ENGINEER (DME) 
Keys:  All My Lab Units (lab unit) 

1. Start and log on to SiteManager LIMS as user dhines. 
LIMS displays the Navigation Panel window. 

2. Double-click the Maintain Test Queue icon. LIMS 
displays the Maintain Test Queue window. 

You’ve accessed the Maintain Test Queue window. 
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Adding Tests to Samples 

To add tests accidentally omitted when the sample was logged, click the 
Add Test button. 

To add a test, select a sample on the Maintain Test Queue window. On the 
toolbar, click the Add Test button. The Add Tests window displays 
additional tests available to assign. Add one or more desired tests to the 
sample. 

Warning! When adding multiple tests at one time, the Remarks window 
that LIMS automatically displays will apply remarks to the last selected 
test only. 

Each newly assigned test has a test number of ‘1,’ a test status of ‘Test in 
Queue,’ and a priority of ‘Medium.’ LIMS automatically populates the lab 
ID, lab name and charge amount. 

 
Figure 6-3.  SiteManager LIMS - Add Tests Window 
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Canceling Tests 

You cannot delete a test in LIMS, but you can cancel a test. To cancel a 
test, select a test on the window. On the toolbar, click the Cancel button. 
The system automatically displays the Remarks window. Enter a valid 
reason for canceling the test. A canceled test will only display in the 
Maintain Test Queue window. 

The system changes the test status to Test Canceled. You cannot modify a 
canceled test other than to add remarks. If you try, the system will display 
a message to inform you that you cannot. 

Note:  If you cancel a test by mistake, you can re-add the test. 

 Exercise 6-2 

In this exercise, learn how to add a test to a sample and cancel a test on 
a sample. 

User ID:  dhines Password:  kentucky Connection:  Server 
Group Name:  DISTRICT MATERIALS ENGINEER (DME) 
Keys:  All My Lab Units (lab unit) 

1. In the first Filter Criteria dropdown list, select the Sample 
ID choice. 

2. In the Filter Criteria text box, type 3722. 

3. Click the Apply button. LIMS selects the 02312KJH093722 
sample record. 

Now, let’s cancel a test. 

4. In the Test Description column, select the VISUAL 
AGGREGATE QUALITY test. 

5. On the toolbar, click the Cancel Test button. LIMS displays 
the Remarks window. 

6. In the Internal Comments field, type WRONG TEST 
ASSIGNED. (DHINES - < mm/dd/yy >) 

7. To close the Remarks window, on the toolbar, click the 
Remarks button. 

NOTE 

YOU CANNOT CANCEL A 
TEST IN SOME 
STATUSES. 

IN SITUATIONS WHERE 
YOU CANNOT CANCEL 
THE TEST, IT IS 
PROBABLY BECAUSE IT 
HAS ALREADY 
OCCURRED. IN WHICH 
CASE, IF YOU DO NOT 
WANT THE TEST TO BE 
SEEN ON REPORTS, 
REVIEWS, AND SO ON. 
THE TEST REVIEWER 
SHOULD MARK THE TEST 
AS NON-REPORTABLE. 
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8. On the toolbar, click the Save button. LIMS changes the test 
status to ‘Test Canceled.’ 

Now, let’s add a test. 

9. On the toolbar, click the Add button. LIMS displays the 
Add Tests window. 

10. In the Additional tests available for assignment pane, 
select the SPECIFIC GRAVITY AND ABSORPTION 
COARSE test. 

11. Click the Add Test button. LIMS displays the test in the 
‘Tests already assigned to the sample’ pane. 

12. In the Tests already assigned to the sample pane, in the 
Test Description column, select SPECIFIC GRAVITY 
AND ABSORPTION COARSE. 

13. Click the Add Test Run button. LIMS displays the Select 
Additional Runs window. 

14. In the Select Additional Runs dropdown list, to accept the 
default of 1, click the OK button. LIMS displays the Add 
Tests window with two runs for that test. 

15. Click the OK button. LIMS automatically displays the 
Remarks window. 

Now, let’s add remarks to the newly added test. 

16. In the Internal Comments field, FORGOT TO ADD 
TEST WHEN CREATING SAMPLE  
(DHINES - < mm/dd/yy >). 

17. To close the Remarks window, on the toolbar, click the 
Remarks button. 

18. On the toolbar, click the Save button. 

You’ve canceled a test and added a test with more than one run. 

KNOWN ISSUE 

LIMS REMOVES THE 
FILTER FROM THE LIST, 
BUT THE CRITERIA STILL 
EXISTS. 

NOTE 

LIMS APPENDS REMARKS 
TO LAST TEST ADDED. BE 
SURE TO COPY REMARKS 
TO ALL RELEVANT 
TESTS. 
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Assigning Priorities and Due Dates to Manage Test Completion Order 

LIMS automatically assigns a Medium priority to tests, but does not assign 
a due date. To assign a different priority to a test, click the Priority 
dropdown list to select a High or Low choice. If necessary, assign a due 
date to the test. 

Important!  LIMS does not display warning messages if the tester fails to 
complete the test by the due date or according to the assigned priority. 

 Exercise 6-3 

In this exercise, learn to assign a higher priority to a test and assign a 
due date. 

User ID:  dhines Password:  kentucky Connection:  Server 
Group Name:  DISTRICT MATERIALS ENGINEER (DME) 
Keys:  All My Lab Units (lab unit); Sample ID Contains 3722 (filter) 

1. In the Filter Criteria text box, type 8373. 

2. Click the Apply button. LIMS selects the 02312JJJ098373 
sample record. 

Now, let’s change the priority. 

3. For the SPECIFIC GRAVITY AND ABSORPTION 
COARSE test, in the Priority column’s dropdown list, 
select the High choice. 

Now, let’s add a due date. 

4. In the Due Date field, type a future date (mm/dd/yy format). 

5. On the toolbar, click the Save button. 

You’ve changed the priority for and added a due date to a test. 
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Assigning Testers 

An individual tester can be assigned to a test. Designating a tester does not 
make the test appear exclusively for that individual on the Enter Test 
Results window. Any qualified tester assigned to the appropriate lab unit 
will be able to view the test in Enter Test Results window.  

Note:  The Tester dropdown list is limited to qualified testers in the 
selected lab unit. 

 Exercise 6-4 

In this exercise, learn how to assign a tester to a test. 

User ID:  dhines Password:  kentucky Connection:  Server 
Group Name:  DISTRICT MATERIALS ENGINEER (DME) 
Keys:  02312JJJ098373 (sample ID);  
           SPECIFIC GRAVITY AND ABSORPTION COARSE (test); 1 (run) 

1. In the Tester dropdown list, select jdavis. 

2. On the toolbar, click the Save button. 

You’ve assigned a tester to a test. 
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Assigning Tests to Different Lab Units 

To choose a different lab unit than the one automatically allocated to a lab 
unit for the test during the creation of the sample, use the Lab ID field.  

 
Figure 6-4.  SiteManager LIMS – Change Labs Window 
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 Exercise 6-5 

In this exercise, learn to assign a test to a different lab unit in the 
Maintain Test Queue window. 

User ID:  dhines Password:  kentucky Connection:  Server 
Group Name:  DISTRICT MATERIALS ENGINEER (DME) 
Keys:  All My Lab Units (lab unit); Sample ID Contains 8373 (filter) 

1. In the Filter Criteria text box, type 8761. 

2. Click the Apply button. LIMS selects the 01314JUY098761 
sample record. 

3. In the Test Description column, select the CONCRETE 
CYLINDER STRENGTH test. 

Now, let’s select another lab to perform the test. 

4. In the lower pane, using your right-mouse button, click on the  
Lab ID field. LIMS displays a window containing a list of labs. 

5. To sort the list in alphabetic order according to lab ID, click 
the Lab ID column heading. 

6. In the Lab ID column, select LU00644. 

7. Click the OK button. LIMS closes the window. 

8. On the toolbar, click the Save button. 

Now, let’s add a remark. 

9. On the toolbar, click the Remarks button. LIMS displays 
the Remarks window. 

10. In the Internal Comments field, type DUE TO WORK 
LOAD, NOT ABLE TO COMPLETE BEFORE DUE 
DATE. (DHINES – < mm/dd/yy >) 

11. To close the Remarks window, on the toolbar, click the 
Remarks button again. 

12. On the toolbar, click the Save button. 

13. To clear the filter, click the Reset button. 

You’ve changed the lab assigned to perform a test. 
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Review 
To display the Maintain Test Queue window: 

1. On the Navigation Panel, double-click the Maintain Test 
Queue icon. 

To add a test to a sample in the Maintain Test Queue window: 

1. On the Maintain Test Queue window, select a sample. 

2. Click the Add button. 

3. In the Add Tests window, select a test from the Additional 
Tests Available for Assignment pane. 

4. Click the Add button. 

5. Click the OK button. 

6. On the Remarks window, enter in a remark why the test was 
added. 

To cancel a test on a sample in the Maintain Test Queue window: 

1. On the Maintain Test Queue window, select a sample.  

2. Click the Cancel button. 

3. On the Remarks window, enter in a remark why the test was 
removed.  

To add a tester to a sample in the Maintain Test Queue window: 

3. On the Maintain Test Queue window, select a test.  

4. In the Tester dropdown list, select the desired tester. 

5. Click the Save button. 
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To add a priority to a test in the Maintain Test Queue window: 

1. On the Maintain Test Queue window, select a test.  

2. Click the Priority field. 

3. Select a Priority in the priority drop down list. 

4. Click the Save button. 

To add a due date to a test in the Maintain Test Queue window: 

1. On the Maintain Test Queue window, select a test. 

2. In the Due Date field, type in the desired due date. 

3. Click the Save button. 

To assign a test to a different lab unit in the Maintain Test Queue 
window: 

1. On the Maintain Test Queue window, select a test.  

2. Right-click in the Lab Unit field to obtain a list of lab units. 

3. In the Lab ID column, select the desired lab ID. 

4. Click the OK button. 

5. Click the Save button. 
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Summary 
In this exercise, demonstrate how to modify data in the Maintain 
Test Queue window. 

User ID:  dhines Password:  kentucky Connection:  Server 
Group Name:  DISTRICT MATERIALS ENGINEER (DME) 
Keys:  All My Lab Units (lab unit) 

1. Create a filter to display only tests for the 
01314YUM096271 sample record. 

2. Add the CONCRETE CYLINDER STRENGTH test. 

3. Add an appropriate remark. 

4. Save. 

5. Make the test High priority with a due date of tomorrow. 

6. Assign wjudd as the tester. 

7. Cancel the CONCRETE CORES test on 
01314YUM096271 sample record. 

8. Add an appropriate remark. 

9. Reset the filter. 

10. Exit SiteManager LIMS. 



6-16 Maintaining Test Queues 
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7.  Reviewing Samples 

In this chapter, you will receive instruction about the following: 

 Understanding the General Workflow 2 

 Accessing the Review Samples Window 3 

 Understanding the Review Samples Workflow 6 

 Understanding Product Review Groups 6 

 Understanding Data View Options 6 

 Viewing and Comparing Test Results 7 

 Accepting Test Results and Indicating Sample Status 11 

 Finalizing Samples 12 

 Sending Tests Back to the Lab 13 

 Review 15 

 Summary 16 

 



7-2 Reviewing Samples 

Understanding the General Workflow 
The following diagram shows the general workflow between SiteManager 
software’s Materials Management and LIMS components. The highlighted 
area denotes the functionality addressed in this chapter. 
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Materials Management

 
Figure 7-1.  General Workflow - Reviewing Samples – Detail 
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Accessing the Review Samples Window 
To review samples, use the Review Samples window. 

 
Figure 7-2.  SiteManager LIMS - Review Samples Window 
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Field Name  Description  
Data View 
Lab Control Number Select to sort by Lab Control Number. 
Sample ID Select to sort by Sample ID. 
Filter Criteria 
Filter Criteria Select criteria from the dropdown lists and enter 

text in the fields to limit the samples displayed on 
the window. 

Apply  Click to activate filter criteria entered by the user. 
Reset Click to clear filter criteria.  
Column Headings 
Acceptance Method * Populated with the method recorded on the 

SiteManager Maintain Sample Information 
window’s Basic Sample Data panel. Verify that the 
correct acceptance method is displayed. 

Sample Status * Select the status of the sample. 
 PENDING - Created a sample record and 

assigned tests. All test results may not be 
complete. 

 COMPLETE - All sampling and/or testing 
criteria have been satisfied. 

 FAILED - Sample did not meet material 
specification requirements. See detailed 
remarks. 

 FAILED AND REMOVED FROM 
PROJECT - Sample did not meet material 
specification requirements. Sample will not 
count toward meeting Contract Sampling 
and Testing requirements. See detailed 
remarks. 

 VOID - Logged a sample record incorrectly 
or revised. 

 INVALID - Sample was inadvertently 
destroyed or contaminated. 

Authorize Select the Authorize check box and save. 
Lab Control Number An umbrella number used to link samples. May use 

during sample review to process multiple samples 
at once. 

Lab Reference Number Simplified sample identifier used in the labs. 
Sample ID Identifies the sample. 
Contract ID List of all contracts assigned to the sample. 
Test Method Method used to test material. 
Test Description Describes the test method. 
Test Number Indicates run of the test on the sample. 
Send Test Back to Lab Select the check box to send a test back to the lab 

for review (Review Tests window). 
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Field Name  Description  
Lab ID Lab unit where the test was performed. 
Material Code Identifies the material. 
Sampler User ID of the sampler. 
Sample Type* Indicates type of sample. 
Producer Supplier* Producer/supplier of the material in the sample. 
Control Number Actual number for the type of control to identify the 

sample. 
Seal Number Seal number on the batch of the material tested. 
Completion Date Date when the sample was marked as complete in 

the lab unit. 
Manufacturer* Manufacturer of the material in the sample. 
Sample Date Date the sampler took the sample. 
Toolbar Buttons 
Remarks Enter/View remarks associated with the selected 

sample. Enter appropriate remarks in the Remarks 
field. 

Table 7-1.  SiteManager LIMS – Review Samples Window (Upper Pane) – Fields 

Note:  When defining criteria for a filter, the asterisk ( * ) that follows 
some of the field names denotes that the corresponding code must be used 
rather than the name. 

 Exercise 7-1 

In this exercise, learn how to access the Review Samples window. 

User ID:  jdavis Password:  kentucky Connection:  Server 
Group Name:  MATERIALS SECTION SUPERVISOR (DME) 
Keys:  Sample ID (data view) 

1. Start and log on to SiteManager LIMS as user jdavis. LIMS 
displays the Navigation Panel window. 

2. Double-click the Review Samples icon. LIMS displays the 
Review Samples window. 

You’ve accessed the Review Samples window. 
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Understanding the Review Samples Workflow 
After the test reviewer marks all tests for a sample as Review Completed, 
LIMS displays the sample with all tests marked Reportable in the Review 
Samples queue for the appropriate sample reviewer. The sample reviewer 
accepts or rejects entries at the sample level after selecting an acceptance 
method and completion status for the entire sample.  

If the results are not acceptable, the sample reviewer may select individual 
test(s) to send back to the lab for additional review. If a test is sent back to 
the lab, the system removes the entire sample record from the Review 
Samples queue. 

Understanding Product Review Groups 
The system administrator assigns sample reviewers to Product Review 
Groups identified to review particular samples. Combinations of contract 
authority, material, sample type and destination lab determine the samples 
that appear in the queue for those sample reviewers. 

Understanding Data View Options 
Sort the sample records in the Review Samples window in two ways: by 
control number or sample ID. 

Viewing Samples by Lab Control Number 

If you select the Lab Control Number data view, LIMS groups the sample 
records together by the control number. When you group the sample 
records by lab control number they must be accepted or rejected at the lab 
control number level. 

Viewing Samples by Sample ID 

If you select the Sample ID data view, LIMS hides the Control Number 
column. 

NOTE 

YOU MAY CHANGE 
THE DEFAULT 
POSITION FOR THE 
LAB CONTROL 
NUMBER COLUMN 
SO THAT THE 
CONTROL NUMBER 
COLUMN APPEARS 
NEXT TO THE 
SAMPLE ID. 

NOTE 

A SAMPLE WITH 
MULTIPLE TESTS 
WILL NOT DISPLAY IN 
THE REVIEW 
SAMPLES WINDOW IF 
ANY TEST 
ASSOCIATED WITH 
THE SAMPLE 
REMAINS IN AN 
INCOMPLETE STATE. 
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Viewing and Comparing Test Results 
To access the test results associated to a sample, click the View/Compare 
Results button. Then, compare the same test method or different test 
methods across one sample or multiple samples. 

In the upper pane, select a row and click the View/Compare Results button to 
display the test results for one test. Select multiple rows and click the 
View/Compare Results button to display the test results for the selected tests. 

 
Figure 7-3.  SiteManager LIMS - Review Samples Window - View/Compare 
Results - Single Sample 

 

Field Name Description 
View/Compare Results Click to view a single test template's results or view 

multiple templates in a grid format at one time—
even across samples. 

Test Template Test template for the compared tests. 
Template Column Labels used to describe the template layout and 

data entry fields to record the test results. LIMS 
changes the color of the columns to red where the 
test results do not meet the minimum or maximum 
standards. 

Min Minimum acceptable value for the spec template. 
Max Maximum acceptable value for the spec template. 
Sample ID / Test 
Number 

Combination of Sample ID and the sample test 
number selected for the grid view results 
comparison. 

Table 7-2.  SiteManager LIMS - Review Samples Window (Lower Pane) – Fields 



7-8 Reviewing Samples 

Viewing Test Results for Single Samples 

LIMS provides a means for you to view test results for a single sample. 

 Exercise 7-2 

In this exercise, learn how to view results for a specific test. 

User ID:  jdavis Password:  kentucky Connection:  Server 
Group Name:  MATERIALS SECTION SUPERVISOR (DME) 
Keys:  NA 

1. In the Test Description column, select the DRY SIEVE 
ANALYSIS test for sample 01312HWM098635. 

Now, let’s view the test results on this test. 

2. Click the View/Compare Results button. LIMS displays 
the results in a grid in the Test Results pane. 

3. In the Test Results pane, on the title bar, click the 
Maximize button. 

4. Review the test results. 

5. In the Test Results pane, on the title bar, click the Restore 
Down button. 

You’ve viewed test results for a single test. 
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Viewing and Comparing Test Results for Multiple Samples 

LIMS provides a means for you to view and compare test results across 
multiple samples. 

 
Figure 7-4.  SiteManager LIMS - Review Samples Window - View/Compare 
Results - Multiple Samples 
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 Exercise 7-3 

In this exercise, learn how to view the test results across samples. 

User ID:  jdavis Password:  kentucky Connection:  Server 
Group Name:  MATERIALS SECTION SUPERVISOR (DME) 
Keys:  NA 

1. On your keyboard, press and hold the Ctrl key. 

2. In the Test Description column, click all DRY SIEVE 
ANALYSIS tests. 

3. Release the Ctrl key. 

Now, let’s compare all test results. 

4. Click the View/Compare Results button. 

5. Note that the test for the 01312HWM098635 sample does 
not show a test template status. 

You’ve viewed test results for a single test on different samples. 

TIP! 

YOU MAY ALSO 
VIEW/COMPARE 
DIFFERENT TESTS 
ACROSS SAMPLES.  
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Accepting Test Results and Indicating Sample Status 
To prepare for finalization by signing off on the test results for an entire 
sample, select the desired choice from the Sample Status * dropdown list. 
Doing so does not remove the sample from the Review Samples queue, 
but serves to indicate that a test has been completed. KYTC has 
configured LIMS to auto-populate the Acceptance Method* dropdown 
list.  

Note:  Select the Sample Status* dropdown choice before selecting the 
Authorize check box. 

When the sample has been finalized, upon selecting the Authorize 
checkbox and saving the record, LIMS displays the acceptance method in 
SiteManager’s Maintain Sample Information window’s Acceptance 
Method* field. 

 
Figure 7-5.  SiteManager LIMS - Review Samples Window –  
Acceptance Method* and Sample Status* Dropdown Lists – Detail 

DEMO 

REARRANGE COLUMNS TO 
BETTER REFLECT 
WORKFLOW  
(ACCEPTANCE METHOD –  
SAMPLE STATUS – 
AUTHORIZE) 

NOTE 

CHOICES AVAILABLE FROM 
THE SAMPLE STATUS 
DROPDOWN LIST INCLUDE 
ALL SAMPLE STATUSES.  

NOT ALL ARE APPROPRIATE 
FOR AUTHORIZING A 
SAMPLE.  

CHOOSING AN 
INAPPROPRIATE STATUS 
COULD RESULT IN A 
SAMPLE NOT SATISFYING 
S&T REQUIREMENTS. 
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Finalizing Samples 
Before the sample will be removed from the Review Samples window, the 
user must complete the Sample Status* dropdown list and the Authorize 
check box. 

Note:  Select the Sample Status * dropdown choices before selecting the 
Authorize check box. 

After the sample progresses from the Review Samples queue, the system 
updates the Maintain Sample Information window’s fields. The system 
populates the Auth By field with the reviewer’s user ID, populates the 
Auth Date with the current system date, and changes the sample status 
from Pending Authorization to Complete. 

 Exercise 7-4 

In this exercise, learn how to indicate sample status and authorize a 
sample. 

User ID:  jdavis Password:  kentucky Connection:  Server 
Group Name:  MATERIALS SECTION SUPERVISOR (DME) 
Keys:  NA 

1. In the upper pane, in the Test Description column, select 
DRY SIEVE ANALYSIS for the 01312HWM098636 
sample. 

2. In the Sample Status * dropdown list, select the 
COMPLETE choice. 

3. In the Authorize column, select the check box. 

4. On the toolbar, click the Save button. LIMS removes the 
sample from the queue. 

You’ve indicated sample status and authorized a sample. 

KNOWN ISSUE 

YOU MUST MANUALLY 
REFRESH THE WINDOW. 
PRESS THE F5 KEY TO 
REFRESH. 

TIP! 

MAY AUTHORIZE 
MULTIPLE SAMPLES AT 
ONE TIME. 
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Sending Tests Back to the Lab 
The sample reviewer selects individual test(s) to send back to the lab for 
further review. The system changes the status to Back to Lab and removes 
the sample record from the Review Samples queue and places the selected 
test in the Review Tests queue. 

 
Figure 7-6.  SiteManager LIMS - Review Samples Window -  
Send Test Back to Lab – Detail 

Review Tests Review SamplesEnter Test Results

SiteManager LIMS: Send Test Back to Lab Workflow

Receive
Sample

in Lab Unit

All
tests

completed

Test E (Run 1) -
Test in Queue (10)

Test(s)
Completed (40)

Test(s)
Approved (60)

Section
Supervisor or Lab

Manager
Tester Section

Supervisor

Sample(s)
Authorized (80)

Received In Testing Pre-authorizationLogged Complete

Receive Sample
in Destination

Lab

Maintain
Sample

Information

Pending

Assign
Tests

Sample
Sample

with 2 Tests
(1 Run each)

Sample
with 2 Tests

(1 Run each)

Test F (Run 1) -
Test in Queue (10)

Back to Lab (81)
All other tests are temporarily
removed from Review Samples

 
Figure 7-7.  Send Test Back to Lab Workflow 
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 Exercise 7-5 

In this exercise, learn how to send a test back to the lab. 

User ID:  jdavis Password:  kentucky Connection:  Server 
Group Name:  MATERIALS SECTION SUPERVISOR (DME) 
Keys:  NA 

1. In the Test Description column, select DRY SIEVE 
ANALYSIS for the 01312HWM098635 sample. 

Now, let’s add a remark. 

2. On the toolbar, click the Remarks button. LIMS displays 
the Remarks window. 

3. In the Remarks (General Remarks) field, type SENT 
BACK TO LAB TO ADD MISSING TEST STATUS. 
(JDAVIS – < mm/dd/yy >) 

4. To close the Remarks window, on the toolbar, click the 
Remarks button again. 

Now, let’s send the test back to the lab. 

5. In the Send Test Back to Lab column, select the check 
box. 

6. On the toolbar, click the Save button. LIMS removes the 
sample from the queue. 

You’ve sent a test back to the lab. 

NOTE 

ONE TEST GOES BACK 
TO LAB, BUT LIMS 
REMOVES THE ENTIRE 
SAMPLE FROM THE 
QUEUE. 
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Review 
To open the Review Samples window: 

1. On the Navigation Panel window, double-click the Review 
Samples icon. 

To view samples by control number: 

1. On the Review Samples window, in the Data View area, 
click the Control Number button. 

2. Move the Control Number column between the 
Completion Status column and the Sample ID column. 

To view samples by sample ID: 

1. On the Review Samples window, in the Data View area, 
click the Sample ID button. 

To view test results: 

1. On the Review Samples window, in the upper pane, select a 
sample’s test row. 

2. Click the View/Compare Results button. 

To send a test back to the lab: 

1. On the Review Samples window, in the upper pane, select 
the Send Test Back To Lab check box. 

2. Click the Save button. 

To finalize a sample: 

1. On the Review Samples window, in the upper pane, select a 
test row. 

2. In the Acceptance* dropdown list, select the desired choice. 

3. In the Completion Status* dropdown list, select the desired 
choice. 

4. In the Finalize column, select the checkbox. 

5. Click the Save button. 
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Summary 
In this exercise, review sample records and send a test back to the lab. 

User ID:  jdavis Password:  kentucky Connection:  Server 
Group Name:  MATERIALS SECTION SUPERVISOR (DME) 
Keys:  NA 

1. View the results for the COARSE AGGREGATE 
QUALITY test on the 01312SCF070001 sample. 

2. Change the sample status to COMPLETE and authorize 
the sample. 

3. Save. 

4. Send the COAL AND LIGNITE COARSE test for the 
01213SAM090568 sample back to the lab. Add a remark 
that all of the results are missing. 

5. Save. 

6. Exit SiteManager LIMS. 
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8.  Viewing Sample Information 

In this chapter, you will receive instruction about the following: 

 Opening View-Only Sample Records 2 

 Creating New Filters 3 

 Understanding Sample Information Views 4 

 Understanding the Sample Details Panel 5 

 Understanding the Contract Details Panel 9 

 Understanding the Other Details Panel 11 

 Understanding the Sample Receive Panel 12 

 Understanding the Tests Assigned Panel 13 

 Understanding the Test Status Panel 14 

 Understanding the Test Results Panel 15 

 Using Generic Filter Criteria 16 

 Deleting Filters 16 

 Creating Multi-Criteria Filters 16 

 Review 18 

 Summary 20 

 



8-2 Viewing Sample Information 

Opening View-Only Sample Records 
Before displaying the View-Only Sample Information window, LIMS 
displays the Open Sample Records window where a user must specify 
criteria to search for samples. To find a specific sample record or groups 
of sample records based upon selected criteria, use the Open Sample 
Records window. 

 
Figure 8-1.  SiteManager LIMS - Open Sample Records Window 

 

Field Name Description  
Filter Dropdown list containing types of available filters (that is, 

Generic or user-specified). 
New Filter Click to create a new filter. 
Delete Filter Click to delete previously created filters. 
Field Name of the field in which the filter criteria is applied. 
Operator Equals, greater than, less than, begins with, and so on. 
Value User-specified text by which to filter in a field. 
And/Or Choose to combine criteria. 
Add Criteria Click to add another row of criteria for additional 

comparisons. 
Delete Criteria Click to remove the selected criterion. 
Clear All Click to remove all selected criteria. 
Open Records Click to invoke the search request. 
Cancel Click to close the Open Sample Records window without 

performing a search request. 

Table 8-1.  SiteManager LIMS - Open Sample Records Window – Fields 



Trns•port SiteManager® and LIMS Training Guide for Kentucky Transportation Cabinet 8-3 

Creating New Filters 
To create a new filter, click the New Filter button, name it, select criteria, 
and click the Save Criteria button. You may create as many filters as you 
need, the system does not have a maximum limit. 

Note:  LIMS retains filter criteria until you clear the criteria. 

 Exercise 8-1 

In this exercise, learn how to create a new filter to display samples 
in the View-Only Sample Information window. 

User ID:  jbowie Password:  kentucky Connection:  Server 
Group Name:  CENTRAL MATERIALS LAB TECHNICIANS (CMLT) 
Keys:  NA 

1. Start and log on to SiteManager LIMS as user jbowie. 
LIMS displays the Navigation Panel window. 

2. Double-click the View-Only Sample Information icon. 
LIMS displays the Open Sample Records window. 

3. Click the New Filter button. LIMS displays the ‘Save New 
Filter As’ window. 

4. In the Save New Filter As field, type SAMPLES IN MY 
LABS. 

5. Click the OK button. 

6. Click the Add Criteria button.  

7. In the Field dropdown list, select Lab Unit. 

8. In the Operator dropdown list, select Contains. 

9. In the Value field, type LU03210. 

10. Click the Open Records button. LIMS displays the View-
Only Sample Information window with the sample records 
that meet the criteria. 

You’ve created a new filter. 

KNOWN ISSUE 

CRITERIA WITH DATE 
FORMATS MUST USE 
MM/DD/YYYY FORMAT 
EVEN THOUGH FIELD 
INDICATES OTHERWISE. 
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Understanding Sample Information Views 
To verify information on a sample record, use the View-Only Sample 
Information window. The upper pane displays samples in the system. By 
selecting a row in the upper pane, the information in the lower pane 
changes for you to review sample details, contract details, other details, 
sample receive information, tests assigned, and test status for the selected 
row. 

 
Figure 8-2.  SiteManager LIMS - View-Only Sample Information Window 
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Understanding the Sample Details Panel 
To display information about the sample, use the Sample Details panel. 
LIMS uses the data from SiteManager’s Maintain Sample Information 
window’s Basic Sample Data and Additional Sample Data panels. 

 
Figure 8-3.  SiteManager LIMS - View-Only Sample Information Window - 
Sample Details Panel 



8-6 Viewing Sample Information 

Field Name Description 
Sample ID Identifies the sample. Automatically populated by the 

system with the value that appears on the Basic Sample 
Data panel. 

Lab Control 
Number 

An umbrella number used to link samples. May use during 
sample review to process multiple samples at once. 

Lab Ref Number Lab Reference Number. Simplified sample identifier used 
in the labs. 

Material Identifies the material. 
Sample Status Identifies the current status of this record. 
Sample Type Indicates type of sample. 
Smpld By User ID of the person who took the sample. 
Sample Date Date the sampler actually took the sample. 
Log Date Date the sample was logged in the system. 
Geographic Area District where the sampler took the sample. 
Authorized By Auto-populated with the ID of the user who authorized the 

sample record. 
Authorized Date Auto-populated. Date the user authorized the sample. 
Acceptance 
Method 

Method by which the sample is being accepted. 

Producer 
Supplier 

Approved producer/supplier for the sampled material. 

Manufacturer Manufacturer of the sampled material. 
Plant Per KYTC policy, do not use this field. 
Plant Type Per KYTC policy, do not use this field. 
Mix Design Type Type of sampled mix design. 
Mix ID Identifies mix associated with the sample. 
Product Name Brand of the sampled material. 
Reference Location referenced on the plans where the sampler took 

the sample. Optional. 
Station Station where the sampler took the sample. Required for 

concrete cylinders, soils, aggregate base, and cores. 
Offset Offset from the station. Required for concrete pavement 

cylinders (indicate left or right from centerline) and 
aggregate base and soils and cores (indicate distance left 
or right from centerline). 

Dist from Fnshd 
Grd 

Distance from Finished Grade. Per KYTC policy, do not 
use this field. Captured in Material Test Templates. 

Sample Origin Description of where the sample originated. Optional. 
Town Town where the sampler took the sample. Optional. 
Sampled From From where the sampler took the sample. Required for 

concrete cylinders structure location. Other locations, as 
needed. 

Requested By Person who requested the sample. Optional. 
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Field Name Description 
Intended Use Intended use of the material. 
Buy USA Indicates if the material sampled fulfills the requirement for 

the Buy USA program. Selected if based on contract 
specifications. 

Witnessed By ID of the witness to the sampler that took the sample. 
Optional, except when KYTC witnesses IAS, Liquid 
Asphalt, and QC samples. 

Control Nbr Control Number. Populated when a control type is 
selected. 

Represented Qty Represented Quantity. Per KYTC policy, do not use this 
field. 

Seal Nbr Seal number on the batch of the material tested. 
Sample Size Indicates the sample size, particularly for samples that 

have more than one unit (for example, 2 cans). Optional. 
Linked Sample 
ID 

Other sample IDs that reference this sample for the 
following reasons: 

 QC samples linked to the corresponding QA 
sample for the material. 

 IAS samples linked to an Acceptance sample. 
 When additional testing must be performed for 

failing samples, the new sample should be linked 
to the failing sample. 

Revised from 
Sample ID 

Auto-populated on the original sample record with the user 
ID of the person who revised the sample record. Only 
relevant when a sample record is revised. Not populated 
on the revised sample record. 

Table 8-2.  SiteManager LIMS - View-Only Sample Information Window - Sample 
Details Panel – Fields 

Understanding Remarks on the Sample Details Panel 

LIMS displays remarks recorded on the sample record in SiteManager’s 
Maintain Sample Information, Receive Sample in Lab Unit, and Review 
Samples windows. 



8-8 Viewing Sample Information 

 Exercise 8-2 

In this exercise, learn how to modify an existing filter and view the 
information displayed in the lower pane of the View-Only Sample 
Information window. 

User ID:  jbowie Password:  kentucky Connection:  Server 
Group Name:  CENTRAL MATERIALS LAB TECHNICIANS (CMLT) 
Keys:  Samples in My Labs (filter) 

1. On the toolbar, click the Open button. LIMS displays the 
Open Sample Records window. 

2. In the Filter dropdown list, select the Sample ID choice. 

3. In the Value field, type 6510. 

4. Click the Open Records button. LIMS displays the row for 
the 01312HWM096510 sample. 

5. In the lower pane, view the Sample Details panel. 

You’ve modified a filter and viewed the Sample Details panel. 
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Understanding the Contract Details Panel 
To display information about the associated contract, use the Contract 
Details panel. LIMS uses the data from SiteManager’s Maintain Sample 
Information window’s Contract panel. 

 
Figure 8-4.  SiteManager LIMS - View-Only Sample Information Window - 
Contract Details Panel 

 

Field Name Description 
Contract ID Identifies the contract associated with the item for Project 

Acceptance samples. 
Project Nbr Project Number. Identifies the project associated with the 

sample. 
Line Item Nbr Line Item Number. Identifies the proposal line number 

associated with the item. 
Item Code Uniquely identifies the item on the contract. 

Usage:  Customized by KYTC. 
Line Item Desc Line Item Description. Describes the item on the 

contract. 
Usage:  Customized by KYTC. 

Represented Qty Represented quantity of the sampled material. Optional. 

Table 8-3.  SiteManager LIMS - View-Only Sample Information Window - 
Contract Details Panel – Fields 

USAGE 

THE PRODUCTION 
VERSION WILL 
INCLUDE THE 
CUSTOMIZATION. 



8-10 Viewing Sample Information 

Understanding Remarks on the Contract Details Panel 

LIMS displays the same remarks available from the Sample Details panel. 

 Exercise 8-3 

In this exercise, learn how to view the Contract Details panel. 

User ID:  jbowie Password:  kentucky Connection:  Server 
Group Name:  CENTRAL MATERIALS LAB TECHNICIANS (CMLT) 
Keys:  01312HWM096510 (sample ID) 

1. Click the Contract Details tab. LIMS displays the 
Contract Details panel. 

You’ve viewed the Contract Details panel. 
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Understanding the Other Details Panel 
To view information about the destination lab, the user ID of the user who 
last modified the sample, and the date the user last modified the sample, 
use the Other Details panel. LIMS uses the data from the Maintain Sample 
Information window’s Other panel. 

 
Figure 8-5.  SiteManager LIMS - View-Only Sample Information Window - Other 
Details Panel 

 

Field Name Description 
Other Type Agency-defined fields for tracking information not 

found elsewhere on the sample record. Also 
includes a system-defined field, Destination Lab, 
for assigning the lab unit that will process the 
sample using LIMS. 

Other Information Displays value entered for the selected choice in 
the Other Type column. 

Table 8-4.  SiteManager LIMS - View-Only Sample Information Window - Other 
Details Panel – Fields 

Understanding Remarks on the Other Details Panel 

LIMS displays the same remarks available from the Sample Details panel. 

 Exercise 8-4 

In this exercise, learn how to view the Other Details panel. 

User ID:  jbowie Password:  kentucky Connection:  Server 
Group Name:  CENTRAL MATERIALS LAB TECHNICIANS (CMLT) 
Keys:  01312HWM096510 (sample ID) 

1. Click the Other Details tab. LIMS displays the Other 
Details panel. 

You’ve viewed the Other Details panel. 
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Understanding the Sample Receive Panel 
To display information about the destination lab and lab unit receiving the 
sample, use the Sample Receive panel. 

 
Figure 8-6.  SiteManager LIMS - View-Only Sample Information Window - 
Sample Receive Panel 

 

Field Name Description 
Dest Receive Date Destination Receive Date. Date the destination lab 

received the sample. Bypassed for all samples. Per 
KYTC policy, this field will be blank. 

Receiving Destination Name of the destination lab that received the 
sample. Bypassed for all samples. Per KYTC 
policy, this field will be blank. 

Lab Unit Receive Date Date the lab unit received the sample. 
Receiving Lab Unit Name of the lab unit that received the sample. 

Table 8-5.  SiteManager LIMS - View-Only Sample Information Window - Sample 
Receive Panel – Fields 

Understanding Remarks on the Sample Receive Panel 

LIMS displays the same remarks available from the Sample Details panel. 

 Exercise 8-5 

In this exercise, learn how to display information on the Sample 
Receive panel. 

User ID:  jbowie Password:  kentucky Connection:  Server 
Group Name:  CENTRAL MATERIALS LAB TECHNICIANS (CMLT) 
Keys:  01312HWM096510 (sample ID) 

1. Click the Sample Receive tab. LIMS displays the Sample 
Receive panel. 

You’ve viewed the Sample Receive panel. 
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Understanding the Tests Assigned Panel 
To display information about the tests assigned to the sample, use the 
Tests Assigned panel. 

 
Figure 8-7.  SiteManager LIMS - View-Only Sample Information Window - Tests 
Assigned Panel 

 

Field Name Description 
Test Meth Test Method. Method used to test material. 
Test Description Describes the test method. 
Smpl Tst Nbr Sample Test Number. Indicates run of the test on the 

sample. 

Table 8-6.  SiteManager LIMS - View-Only Sample Information Window - Tests 
Assigned Panel – Fields 

Understanding Remarks on the Tests Assigned Panel 

LIMS displays any public remarks entered in Enter Test Results, Maintain 
Test Queue or Review Tests windows. 

 Exercise 8-6 

In this exercise, learn how to use the information on the Tests 
Assigned panel. 

User ID:  jbowie Password:  kentucky Connection:  Server 
Group Name:  CENTRAL MATERIALS LAB TECHNICIANS (CMLT) 
Keys:  01312HWM096510 (sample ID) 

1. Click the Tests Assigned tab. LIMS displays the Tests 
Assigned panel. 

You’ve viewed the Tests Assigned panel. 
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Understanding the Test Status Panel 
To display information about the status of the various tests assigned to a 
sample, use the Test Status panel. 

 
Figure 8-8.  SiteManager LIMS - View-Only Sample Information Window - Test 
Status Panel 

 

Field Name Description 
Test Meth Test Method. Method used to test material. 
Test Description Describes the test method. 
Smpl Tst Nbr Sample Test Number. Indicates run of the test on 

the sample. 
Test Status Current status of the test. 
Priority Priority assigned to the test by the supervisor. 
Due Dt Due Date. Assigned to the test by the supervisor. 
Reportable Indicates whether the test is reportable. Do not 

clear. 
Test Result Val Test Result Value. Final test result value for the 

template 
Tester ID Tester assigned by the supervisor to perform or 

oversee the test. Optional. 
Lab Unit Indicates where the test will be performed. 
Chrg Amt Charge Amount. Cost of the test. 
Start Dt Start Date. When the tester first entered test 

results. 
Actl Complt Dt Actual Completion Date. Date when the test was 

marked as complete. 

Table 8-7.  SiteManager LIMS - View-Only Sample Information Window - Test 
Status Panel – Fields 
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Understanding Remarks on the Test Status Panel 

LIMS displays any public remarks and internal lab remarks entered in 
Enter Test Results, Review Tests, and Maintain Test Queue windows. 

 Exercise 8-7 

In this exercise, learn how to use the information on the Test Status 
panel. 

User ID:  jbowie Password:  kentucky Connection:  Server 
Group Name:  CENTRAL MATERIALS LAB TECHNICIANS (CMLT) 
Keys:  01312HWM096510 (sample ID) 

1. Click the Test Status tab. LIMS displays the Test Status 
panel. 

You’ve viewed the Test Status panel. 

Understanding the Test Results Panel 
To display information about the results of the various tests assigned to a 
sample, use the Test Results panel. 

Usage:  Customized for KYTC. Test Results panel will appear in the 
production version of the software. 
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Using Generic Filter Criteria 
The Filter dropdown list contains a default filter named Generic. To create 
search criteria for samples, use the generic filter. The Generic filter retains 
the filter criteria defined in the Open Sample Records window until you 
clear the filter. 

Tip!  Create filters for frequently used search criteria. 

Deleting Filters 
To delete a filter from the Open Sample Records window, select a Filter 
Name in the Filter dropdown list and click the Delete Filter button. 

Creating Multi-Criteria Filters 
To further refine a filter search, use the multi-criteria feature. To select 
samples by two or more criteria, use the Open Sample Records window. 

 
Figure 8-9.  SiteManager LIMS - Open Sample Records Window (Multi-Criteria) 
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 Exercise 8-8 

In this exercise, learn how to filter samples based on multiple 
criteria. 

User ID:  jbowie Password:  kentucky Connection:  Server 
Group Name:  CENTRAL MATERIALS LAB TECHNICIANS (CMLT) 
Keys:  NA 

1. On the toolbar, click the Open button. LIMS displays the 
Open Sample Records window. 

2. Click the New Filter button. LIMS displays the Save New 
Filter As window. 

3. In the Save New Filter As field, type  
CONTRACT / MATERIALS. 

4. Click the Add Criteria button.  

5. In the Field dropdown list, select Contract ID. 

6. In the Operator dropdown list, select Equals. 

7. In the Value field, type 061043. 

Now, let’s add more criteria. 

8. Click the Add Criteria button. 

9. In the And/Or dropdown list, verify that the And choice is 
selected by default. 

10. In the Field dropdown list, select Material Code. 

11. In the Operator dropdown list, select Equals. 

12. In the Value field, type 40905. 

13. Click the Open Records button. 

Now, let’s view a record. 

14. In the Sample ID column, select 01210GAH090045. 

15. View the details in the lower pane. 

You’ve created a multiple-criteria filter. 



8-18 Viewing Sample Information 

Review 
To open the View-Only Sample Information window: 

1. On the Navigation Panel, double-click the View-Only 
Sample Information icon. 

To open the Open Sample Records window: 

1. On the View-Only Sample Information window’s toolbar, 
click the Open button. 

To create a new filter: 

1. On the Navigation Panel, double-click the View-Only 
Sample Information icon. 

2. In the Filter dropdown list, select the Generic choice. 

3. Click the Add Criteria button. 

4. In the Field dropdown list, select the desired choice. 

5. In the Operator dropdown list, select the desired choice. 

6. In the Value field, type the desired text. 

7. Click the Open Records button. 
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To create a multi-criteria filter: 

1. On the Open Sample Records window, in the Filter 
dropdown list, select the Generic choice. 

2. Click the Add Criteria button.  

3. In the Field dropdown list, select the desired choice. 

4. In the Operator dropdown list, select the desired choice. 

5. In the Value field, type the desired text. 

6. Click the Add Criteria button again. 

7. In the And/Or dropdown list, select the desired choice. 

8. In the Field dropdown list, select the desired choice. 

9. In the Operator dropdown list, select the desired choice. 

10. In the Value field, type the desired text. 

11. Click the Open Records button. 

To clear all criteria: 

1. On the Open Sample Records window, in the Filter 
dropdown list, select the desired choice. 

2. Click the Clear All button. 

3. Click the Open Records button. 

To delete a filter: 

1. On the Open Sample Records window, in the Filter 
dropdown list, select the desired choice. 

2. Click the Delete Filter button. 

To view Sample Details, Contract Details, Other Details, Sample 
Receive, Tests Assigned, or Test Status panels: 

1. On the View-Only Sample Information window, in the 
upper pane, select the desired sample record. 

2. In the lower pane, click the desired tab. 
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Summary 
In this exercise, enter criteria to filter samples. 

User ID:  jbowie Password:  kentucky Connection:  Server 
Group Name:  CENTRAL MATERIALS LAB TECHNICIANS (CMLT) 
Keys:  01210GAH090045 (sample ID) 

1. Create a filter to locate the samples where Abe Lincoln was 
the sampler. 

2. Create another filter to locate all samples where the 
material name pertains to asphalt. 

3. Why was a retest ordered for sample 01312SHJ090004? 
___________________________ 

4. Exit SiteManager LIMS. 

 

ANSWERS 

3.  FAILING M-VALUE. 

TIP! 

REMEMBER CASE-
SENSITIVITY. 

REMEMBER THAT AN 
ASTERISK MEANS TO 
PROVIDE CODE. 

USE LESS 
RESTRICTIVE 
SEARCHES FOR MORE 
RESULTS (FOR 
EXAMPLE ‘ASPH’ 
INSTEAD OF 
‘ASPHALT’). 

TIP! 

REMEMBER TO USE 
THE USER ID (ALL 
LOWERCASE) FOR THE 
SAMPLER. 
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9.  Creating Sample Records from Daily Work 
Reports 

In this chapter, you will receive instruction about the following: 

 Selecting an Item for the Sample 2 

 Viewing Material Inspection Details 4 

 Creating the Sample Record 9 

 Review 19 

 Summary 21 

 Questions and Answers 22 

 



9-2 Creating Sample Records from Daily Work Reports 

Selecting an Item for the Sample 
To make use of the material information recorded on a DWR, create a 
sample record directly from the DWR. 

On the Work Items panel, select the item for which you need to create a 
sample record. 

 
Figure 9-1.  Daily Work Reports Window - Work Items Panel (Record Work Item View)  
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 Exercise 9-1 

In this exercise, access the Daily Works Reports window and select 
the contract, DWR, and item. 

User ID:  cgayle Password:  kentucky Connection:  Server 
Group Name:  Inspector (INSP) 
Keys:  N/A 

1. Start and log on to SiteManager as cgayle. 

2. On the Main Panel panel, double-click the Daily Work 
Reports icon. 

3. On the Daily Work Reports panel, double-click the Daily 
Work Reports icon. SiteManager displays the Daily Work 
Reports window. 

4. On the toolbar, click the Open button. SiteManager displays 
the Contract ID window. 

5. In the Contract ID area, double-click 061043. SiteManager 
displays the Inspector area. 

6. In the Inspector Name column, double-click cgayle - Gayle, 
Crystal. SiteManager displays the Date area. 

7. In the DWR Date column, double-click 01/13/09. SiteManager 
displays the DWR for that date. 

8. On the Daily Work Reports window, click the Work Items 
tab. SiteManager displays the list of available contract items. 

9. In the Instld column, double-click the row with the selected 
check box. – Project Number DE06300750643, Line Item 
Number 0690, Item Code 08100 – CONCRETE-CLASS A.  
SiteManager displays the Work Item panel’s Record Work 
Item view. 

You’ve accessed the Daily Works Reports window and selected the 
contract, DWR, and item. 
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Viewing Material Inspection Details 
The Material Inspection Detail window is accessible from the Record 
Work Item folder tab displaying daily usage records for a selected work 
item.  The Material Inspection Detail window can be accessed from the 
Services menu option or from the Open Material Inspection Detail icon 
located on the toolbar.  The Material Inspection Detail window is only 
accessible from the Record Work Item window. 

The Material Inspection Detail window has the following panels: 
• Contract Item Info 
• Associated Materials 
• Sampling & Testing Requirements 

The Material Inspection Detail window will display contract item 
information from the DWR Record Work Item folder tab in the top panel. 
The middle panel will display all contract materials associated with the 
item code.  If the material has Contract Sampling and Testing 
Requirements defined, the Contract S&T column will be checked. If 
samples were previously created for the selected material from the DWR 
window, the DWR Sample field will be checked. Users can select a 
material by clicking on a Material Component, displaying associated Test 
Methods in the lower (third) panel. 

The third panel will display contract sampling and testing requirement 
information for the selected material in the middle panel. If contract 
sampling and testing requirements have not been defined for the material, 
this panel will be blank. The data displayed in this panel is information 
only and no data from this panel is carried over to the sample window to 
create samples. 
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Figure 9-2.  Material Inspection Detail Window 
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Field Name Description 
Key Information 
Contract ID ID for the contract. 
Inspector Creator of the DWR. 
DWR Date Date the DWR was created. 
Recorded Work Information 
Project Nbr Project Number. 
Line Itm Nbr Line Item Number. Contract line item number of the item. 
Item Code ID for the item. 
Category Nbr Category Number. Category of the item. 
Item Desc Item Description. Short description of the work item. 
Unit Price Cost per unit of measure. 
Supp Desc 1 Supplemental Description 1. 
Supp Desc 2 Supplemental Description 2. 
Qty Reported to 
Date 

Quantity Reported to Date. Total of all reported quantities 
on DWRs, whether authorized or unauthorized and 
regardless of inclusion on an estimate. 

Qty Authorized to 
Date 

Quantity Authorized to Date. Total of all reported 
quantities on authorized DWRs. 

Units Type Price per unit of item. 
Qty Installed to 
Date 

Quantity Installed to Date. Total of all authorized reported 
quantities on DWRS included in an estimate of any status. 
Will always equal the Qty Paid to Date value, unless 
adjusted on the Estimate Item Detail window. 

Bid Qty Bid Quantity. Original amount bid for an item. 
Pay to Plan Qty Pay to Plan Quantity. Indicates if line item is paid to plan 

quantity. No overruns allowed. 
Status Item status (active, closed) 
Qty Paid to Date Quantity Paid to Date. Total quantity reported on DWRs 

that were authorized in diaries and included in an estimate 
of any status. 

Current Contract 
Qty 

Current Contract Quantity. Current contract quantity of the 
contract line item including any change orders. Calculated 
by the sum of bid quantity and the net change order 
quantity. 

Material Inspection Detail Information 
Material 
Component 

Short material description. 

Cont Est Matrl 
Qty 

Contract Estimated Material Quantity. Current quantity of 
contract items multiplied by the conversion factor. 

Satisf Repr Matrl 
Qty  

Satisfied Represented Material Quantity. Total material 
quantity reported on the Contract panel of the Maintain 
Sample Information window. 
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Field Name Description 
Reprt Matrl Qty Reported Material Quantity. Total material installed is 

calculated based on installed quantity of contract item 
multiplied by the conversion factor. 

Matrl Unit Material Unit. Item material unit. 
Conversion 
Factor 

Used by the required samples calculation to convert 
current quantity to required quantity. 

Contract S&T Contract Sampling and Testing. Indicates item has 
contract sampling and testing requirements defined. 

DWR Sample Indicates sample was created from DWR. 

Contract Sampling and Testing Requirements Information 
Test Method Unique ID to identify the method used for testing the 

material. 
Sampling Rate Rate at which a sample must be collected. 

Sampling 
Frequency 

Frequency at which a sample must be collected. 

Acceptance 
Method 

Identifies how the material will be accepted on the 
contract. 

Sample Type Identifies the type of the test being performed. 

P/S Code Producer/Supplier Code. Unique ID for the 
producer/supplier. 

P/S Name Producer/Supplier Name. Name of the producer/supplier. 

Table 9-1.  Material Inspection Detail Window – Fields 
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 Exercise 9-2 

In this exercise, learn to view material inspection details. 

User ID:  cgayle Password:  kentucky Connection:  Server 
Group Name:  Inspector (INSP) 
Keys: N/A 

1. On the toolbar, click the Open Material Inspection Detail 
Window button. SiteManager displays the Material 
Inspection Detail window. 

2. In the middle pane (the Material Component) select 
CEMENT TYPE 1. In the lower pane, SiteManager 
displays the test methods associated with the selected 
material. 

You’ve viewed material inspection details. 
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Creating the Sample Record 
Create Sample for Selected Material 

From the Material Inspection Detail window, the user can click on the 
Services, Create Sample menu option or the tool bar icon.  SiteManager 
will open the Maintain Sample Information window for the selected 
material.  Fields in the Maintain Sample Information window will be 
populated from information available in the Material Inspection Detail 
window. 

The user can view information in the Maintain Sample Information 
window by clicking on the Services, Open Sample window menu option 
or the tool bar icon.  If more than one sample was created for the DWRs 
material a window will be populated listing all the samples created for the 
material.  Users can pick a sample and click OK to open the selected 
sample. 

 Exercise 9-3 

In this exercise, create a sample record that uses the information 
already entered for the material. 

User ID:  cgayle Password:  kentucky Connection:  Server 
Group Name:  Inspector (INSP) 
Keys:  N/A 

1. On Material Inspection Detail window’s toolbar, click the 
Create Sample for Selected Material   button. 
SiteManager displays the Maintain Sample Information 
window with pre-populated information about the material. 
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Recording Basic Sample Data 

Maintain Sample Information window is opened with the Material 
field populated.  The user will populate the remaining appropriate 
fields. 

 
Figure 9-3.  Maintain Sample Information Window - Basic Sample Data Panel 
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 Exercise 9-4 

In this exercise, add to the sample record you created from the item 
on the DWR. 

User ID:  cgayle Password:  kentucky Connection:  Server 
Group Name:  Inspector (INSP) 
Keys: N/A 

1. In the Sample ID field, enter a valid ID in the following 
format: 
 
DDSSSIIIYY####. 
 

   Remember, DD – use your District number.  SSS 
– use your Section number.  III –Use your initials ALL 
UPPERCASE.  YY – Use the current year.  #### - Start 
each year with the sequence number 0001. 
 

2. In the Smpl Type dropdown list, select the Project 
Acceptance choice. 

3. In the Acpt Meth dropdown list, select the Test Results 
choice. 

4. Using the right mouse button, click on the Sampler field. 

5. On the object menu, select the Search choice. SiteManager 
displays the Search Window. 

6. In the Sampled By column, double-click jbowie - Bowie, 
James. SiteManager displays the sampler in the Maintain 
Sample Information window. 

7. Using the right mouse button, click on the P/S field. 

8. On the object menu, select the Search choice. SiteManager 
displays the Search Window. 

9. In the Producer Supplier Name column, double-click 
COP070021 – CEMEX@LOUISVILLE. SiteManager 
displays the sampler in the Maintain Sample Information 
window. 
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10. In the Geog Area dropdown list, select the District 05. 

11. On the toolbar, click the Save button. 
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Record Additional Sample Data 

 
Figure 9-4.  Maintain Sample Information Window - Addtl Sample Data Panel 

 Exercise 9-5 

In this exercise, learn how to record additional sample data. 

User ID:  cgayle Password:  kentucky Connection:  Server 
Group Name:  Inspector (INSP) 
Keys:  N/A 

1. Click the Addtl Sample Data tab. SiteManager displays the 
Addtl Sample Data panel. 

2. In the Control Type dropdown list, select LOT NUMBER. 

3. In the Cntrl Number, enter LT1238. 

4. On the toolbar, click the Save button. 

You’ve recorded additional sample data. 
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Recording Contract Sample Data 

To associate sample details and test results for a material to 
specific contracts and contract items, use the Contract panel. 

Since the sample record was generated from a DWR, the contract 
item is automatically associated to the same contract as the DWR. 

 
Figure 9-5.  Maintain Sample Information Window - Contract Panel 

 Exercise 9-6 

In this exercise, learn to record represented quantity information for 
the contract. 

User ID:  cgayle Password:  kentucky Connection:  Server 
Group Name:  Inspector (INSP) 
Keys: N/A 

1. Click the Contract tab. SiteManager displays the Contract 
panel. 
 
Note:  The Sample is associated with the DWR contract. 

You’ve recorded the represented quantity for the contract. 
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Recording Other Sample Data 

 
Figure 9-6.  Maintain Sample Information Window - Other Panel 
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 Exercise 9-7 

In this exercise, record the destination lab and any other 
information. 

User ID:  cgayle Password:  kentucky Connection:  Server 
Group Name:  Inspector (INSP) 
Keys: N/A 

1. Click the Other tab. 

2. In the Type dropdown list, select the Destination Lab 
choice. 

3. Using the right mouse button, click on the ID field. 

4. On the object menu, select the Search choice. SiteManager 
displays the Search Window. 

5. In the Destination Lab column, double-click Central 
Office Materials. 

6. On the toolbar, click the Save button. 

7. On the toolbar, click the Close button. 
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Viewing Material Details from the Material Inspection Detail Window 

From the Material Inspection Detail window, click the View Material 
button to view inquiry-only information about the selected material in the 
Material Detail window.  This is the same window that was reviewed in 
the Material Information section. 

 
Figure 9-7.  Material Detail Window - Description Panel 

 

 
Figure 9-8.  Material Detail Window - Tests Panel  
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 Exercise 9-8 

In this exercise, learn to access the Material Detail window. 

User ID:  cgayle Password:  kentucky Connection:  Server 
Group Name:  Inspector (INSP) 
Keys:  N/A 

1. In the middle pane of the Material Inspection Detail 
window, in the Material Component column, select  
Class F FLYASH. 
 
NOTE:  The DWR Sample Check box indicates a sample 
has been created for the material. 

2. On the toolbar, click the View Material button. 
SiteManager displays the Material Detail window’s 
Description panel. 

3. Click the Tests tab. SiteManager displays the Tests panel. 

4. Click the Close button to return to the Material Inspection 
Detail window. 

You’ve accessed the Material Detail window for the selected 
material. 
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Review 
To display the Daily Work Reports window: 

1. On the Main Panel panel, double-click the Daily Work 
Reports icon. 

2. On the Daily Work Reports panel, double-click the Daily 
Work Reports icon. 

To display the Material Inspection Detail window (from the Daily 
Work Reports window): 

1. On the Daily Work Reports window’s Work Items panel’s 
Record Work Item view’s toolbar, click the Open Material 
Inspection Detail Window button. 

2. In the Material Component column, select the desired 
material. 

To create a sample record from a DWR: 

1. On Material Inspection Detail window’s toolbar, click the 
Create Sample for Selected Material button. 

2. On the Maintain Sample Information window, in the Smpl 
Type dropdown list, select the desired choice. 

3. Complete the desired optional fields. 

4. In the Geog Area dropdown list, select the desired choice. 

5. On the toolbar, click the Save button. 

6. Click the Addtl Sample Data tab. 

7. Complete the desired optional fields. 

8. On the toolbar, click the Save button. 

9. Click the Contract tab. 

10. If necessary, in the Represented Qty field, type the desired 
value. 

11. On the toolbar, click the Save button. 

12. Click the Other tab. 
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13. In the Type dropdown list, select the Destination Lab 
choice. 

14. Using the right mouse button, click on the ID field. 

15. On the object menu, select the Search choice. SiteManager 
displays the Search Window. 

16. In the Destination Lab column, double-click the desired 
choice. 

17. If necessary, insert additional rows. 

18. On the toolbar, click the Save button. 
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Summary 
Create a second Sample Information Record from a DWR.  Hint:  The first 
Sample Information Record was created in the Exercises. 

Contract:  061043 

Inspector: cgayle – Gayle, Crystal 

DWR Date:  01/13/09 

Material: 

Project Number: DE06300750643 

Line Item Number:  0690 

Item Code: 08100 – CONCRETE CLASS A 

Material Component:  CEMENT TYPE I, Material Code 40100 

Sample Type:  Project Acceptance 

Acceptance Method:  Test Results 

Sampler: jbowie – Bowie, James 

Producer Supplier:  COP070021 – CEMEX@LOUISVILLE 

Geographic Area:  District 05 

User your district and section number to create a valid sample id. 
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Questions and Answers 
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Answers 

In this appendix, find the answers to all of the questions in the exercises: 

 

Assigning Destination Labs and Tests 

Exercise 2-3 

16.  Asphalt Emulsion 

Summary 

4.  No. you cannot remove required tests. 

Entering Test Results 

Exercise 4-6 

5.  High 

6.  wjudd 

Summary 

2.  2 

3.  Need to verify load values. 

11.  Yes 

Viewing Sample Information 

Summary 

3.  Failing m-Value. 



2 Answers 
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